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About This Guide

CAUTION! ABBREVIATED SAFETY ALERTS. Hazard symbols and hazard
types specified in procedures may be abbreviated in this document. For the
complete safety information, see the “Safety” appendix in this document.

IMPORTANT! Before using this product, read and understand the information the
“Safety” appendix in this document.

Revision history

Revision Date Description
A August 2009 First publication.
B June 2010 Updated PCR patent statements.
C January 2013 Updated to reflect AccuSEQ® Software v2.0.
Purpose
The AccuSEQ® Software v2.0 Mycoplasma SEQ Experiments Getting Started Guide
provides reference information for the AccuSEQ® Software and describes how to
prepare, maintain, and troubleshoot the system.
Prerequisites

This service guide is intended for service personnel who have been specifically trained
by Life Technologies Corporation. The manufacturer is not liable for damage or injury
that results from use of this manual by unauthorized or untrained parties.

This guide uses conventions and terminology that assume a working knowledge of the
Microsoft® Windows® operating system, the Internet, and Internet-based browsers.

AccuSEQ® Software v2.0 Mycoplasma SEQ Experiments Getting Started Guide 9



About This Guide
User attention words

User attention words

10

Five user attention words may appear in this document. Each word implies a
particular level of observation or action as described below:

Note: Provides information that may be of interest or help but is not critical to the use
of the product.

IMPORTANT! Provides information that is necessary for proper instrument operation
or accurate chemistry kit use.

CAUTION! Indicates a potentially hazardous situation that, if not avoided, may
result in minor or moderate injury. It may also be used to alert against unsafe
practices.

WARNING! Indicates a potentially hazardous situation that, if not avoided,
could result in death or serious injury.

DANGER! Indicates an imminently hazardous situation that, if not avoided,
will result in death or serious injury.

Except for IMPORTANTS, the safety alert words in user documentation appear with an
open triangle figure that contains a hazard symbol. These hazard symbols are identical
to the hazard symbols that are affixed to the instrument. See the “Safety” appendix for
descriptions of the symbols.

AccuSEQ® Software v2.0 Mycoplasma SEQ Experiments Getting Started Guide



Get Started

This chapter covers:

B About the MycoSEQ"™ Mycoplasma detection system. ..................... 11

About the AccuSEQ® SOftWare. . . . ..o vttt 11
B About Mycoplasma SEQ experiments. . ............ ..., 12
B Howtousethisguide ............ ... ... ... ... 14
B About the example Mycoplasma SEQ experiment . ........................ 15
B Example experiment workflow .......... ... .. i 18

Note: For more information about any of the topics discussed in this guide, access the
Help system by pressing F1, by clicking @ in the toolbar of the AccuSEQ® v2.0
Software window, or by selecting Help » Contents and Index.

About the MycoSEQ™ Mycoplasma detection system

Components of the MycoSEQ"" Mycoplasma Detection System include:
e Software — AccuSEQ® Software v2.0
¢ Instrument — Applied Biosystems 7500 Fast Real-Time PCR System
¢ Reagents -
- PrepSEQ® Sample Preparation Kits
- MycoSEQ™ Mycoplasma Detection Kits

About the AccuSEQ® Software

AccuSEQ® v2.0 Software is detection and analysis software used with Real-Time PCR
(polymerase chain reaction) assays for impurity and contaminant analysis in
pharmaceutical quality control and process development environments.

AccuSEQ® Software v2.0 Mycoplasma SEQ Experiments Getting Started Guide 1



1 Get Started
About Mycoplasma SEQ experiments

AccuSEQ® v2.0 Software features include:

Support for Applied Biosystems 7500 Fast Real-Time PCR Systems —
AccuSEQ® Software enables you to set up, run, and analyze experiments using
the 7500 Fast instrument with two workflows:

— SEQ Experiment Workflow — To set up, run, and analyze Mycoplasma
experiment samples prepared with the PrepSEQ® Sample Preparation Kits
or MycoSEQ™ Mycoplasma Detection Kits.

— Custom Experiment Workflows — To set up, run, and analyze your own
standard curve, melt curve, or presence/absence experiments.

Quality and results summaries — Provide results in graphical and tabular format.

Security, Audit, and Electronic Signature (SAE) Module — Enables the
AccuSEQ® v2.0 Software Administrator to control access to the software and
determine auditing and electronic signature requirements.

Instrument Maintenance Manager — Provides step-by-step instructions for
performing instrument calibration and verification runs.

About Mycoplasma SEQ experiments

About the
Mycoplasma SEQ
experiment
workflow

12

Mycoplasma SEQ experiments are presence/absence experiments that include a melt
curve. Perform a Mycoplasma SEQ experiment to detect the presence of Mycoplasma
species DNA in a sample.

Note: In this guide, the term experiment refers to the entire process of performing a run
using the 7500 Fast system, including setup, run, and analysis.

The Mycoplasma SEQ experiment workflow is designed to set up, run, and analyze
samples prepared with the PrepSEQ® Sample Preparation Kits.

The Mycoplasma SEQ experiment workflow:

Creates an experiment to detect the presence of Mycoplasma species DNA in a
sample.

Allows you to:
— Specify the number of samples and controls
— Enter sample names
— Specify sample volume per reaction
Provides a suggested plate layout, but allows you to modify the plate layout.

Generates a reaction set-up worksheet and plate layout diagram that includes
reagent volumes needed and optional instructions for preparing samples.

Includes optimized thermal-cycling settings.
Provides a summary of sample and control results.

Provides detailed call assessments and troubleshooting suggestions for review of
failed results.

Provides results reports that you can print, or save as pdf (Adobe® Acrobat® file
type), html, ppt (Microsoft® PowerPoint® file type), or xIs (Microsoft® Excel® file

type).

AccuSEQ® Software v2.0 Mycoplasma SEQ Experiments Getting Started Guide



About the
MycoSEQ™
Mycoplasma
Detection Kits

About the PCR
reactions

About the run
method

About the analysis

Chapter 1 Get Started 1
About Mycoplasma SEQ experiments

The MycoSEQ"™ Mycoplasma Detection Kits are designed for routine screening and
detection of Mycoplasma species (mycoplasmas) and other closely related species such
as Acholeplasma laidlawii and Spiroplasma citri. Based on SYBR® Green dye technology,
this assay is optimized for broad detection of mycoplasmas. When used with the
recommended sample preparation, this assay provides the specificity and sensitivity
needed for routine use in the monitoring of cell lines, raw materials, and
biopharmaceutical product-manufacturing.

For a Mycoplasma SEQ experiment, you prepare PCR reactions that contain multiple
primers designed to amplify the mycoplasma targets and a reagent to detect
amplification of the targets in unknown samples.

The reactions in a Mycoplasma SEQ experiment are:

¢ Unknown — A DNA sample from media, cell culture, or other source that you are
testing for the presence of mycoplasmas.

¢ Negative Control — A reaction solution that contains water or buffer instead of
sample template.

¢ Positive Control (Mycoplasma Real-Time PCR DNA Control) — A specially
designed plasmid DNA used as the positive control whose amplification mimics
the expected amplification of a target.

* (Optional, but recommended) Inhibition Control — A reaction solution that includes
the Power SYBR® Green PCR master mix, the unknown sample, and the positive
control (Mycoplasma Real-Time PCR DNA control).

In Mycoplasma SEQ experiments, the run method is pre-determined by the AccuSEQ®
Software and is not editable. The run method includes the following stages:

* Holding - In the thermal profile for a Mycoplasma SEQ experiment, a stage that
includes a single step. The holding stage is performed before PCR amplification to
activate the AmpliTaq Gold® enzyme.

* Cycling (Amplification) — Part of the run method in which PCR produces
amplification of the target.

* Melt (Dissociation) curve — In the thermal profile for a Mycoplasma SEQ
experiment, a stage with a temperature increment to generate a melt curve that is
required to determine the results for the experiment. The melt curve stage is
performed after PCR amplification to collect endpoint fluorescence data.

Fluorescence data collected during the run method are stored in an experiment data
file (*.eds).

Data collected from the run method are used to automatically determine Mycoplasma
SEQ experiment presence/absence calls. The results are reported in the following
screens:

* Results Summary — Provides a summary of pass, fail, present, absent, and review
results, and displays results in plate view or table view.

* Quality Summary — Provides a description and troubleshooting information for
samples requiring additional review.

* Plot Analysis — Amplification Plot, Melt Curve, Multicomponent Plot, Raw Data
Plot, and Multiple Plots View can be used to further investigate results, modify
Cr settings, and re-analyze the data.

AccuSEQ® Software v2.0 Mycoplasma SEQ Experiments Getting Started Guide 13



1 Get Started
How to use this guide

For more For information on:

information * Mycoplasmas, and the Mycoplasma assay and detection kit — Refer to the
MycoSEQ® Mycoplasma Detection Kits User Guide.

* The 7500 Fast system and supported consumables — Refer to the Applied
Biosystems 7500/7500 Fast Real-Time PCR System Maintenance Guide.

* SYBR® Green dye technology — Refer to the Applied Biosystems Real-Time PCR
Systems Reagent Guide.

e Custom experiments (standard curve, presence/absence, and melt curve) — Refer
to the AccuSEQ®Software v2.0 Custom Experiments Quick Reference Card.

How to use this guide

Using this guide as  Using example experiment data provided with the AccuSEQ® Software, you can use
a tutorial this guide as a tutorial for performing a Mycoplasma SEQ experiment on a 7500 Fast
system. For the example experiment, follow the procedures in chapters 2 through 7:

Chapter

Procedure

2

Set up the experiment using the SEQ Experiment workflow in the AccuSEQ®

Software.

Prepare the experiment, using the reagents and volumes calculated by the

SEQ Experiment workflow in Chapter 2.

Run the experiment on a 7500 Fast instrument.

Review the Results Summary.

[Optional) Review the analysis results.

N | o~ o B~

[Optional) Investigate the analysis results.

For more information, see “About the example Mycoplasma SEQ experiment” on

page 15.
Using this guide After completing the tutorial exercises in chapters 2 through 7, use this guide to lead
with your own you through your own Mycoplasma SEQ experiments. Each procedure in Chapters 2
experiments through 7 includes a set of guidelines, marked with the heading Guidelines for your

experiment, that you can use to perform your own experiments.

Additionally, you can use one of the other workflows provided in the AccuSEQ®
Software to perform your experiments. The table below provides a summary of all the
workflows available in the AccuSEQ® Software.

Workflow Description See...
SEQ Set up a new experiment for specific Applied Biosystems | Chapter 2
Experiment SEQ assay(s) with guidance from the software. The SEQ

Experiment workflow calculates reagent volumes,
determines optimum plate setup, guides you through
experiment set up, uses optimized thermal cycling
conditions, and performs data analysis.
SEQ Template | Set up a new SEQ experiment using setup information Appendix A

from a template.

14
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Chapter 1 Get Started 1
About the example Mycoplasma SEQ experiment

Workflow Description See...
Custom Set up a new experiment using advanced options, Documentation
Experiment recommended for experienced users. The Custom and Support

Experiment workflow allows design flexibility as you
create your own experiment.

Note: An experiment you create in the SEQ experiment workflow cannot be accessed
from the custom experiment workflow.

About the example Mycoplasma SEQ experiment

To illustrate how to perform Mycoplasma SEQ experiments, this guide leads you
through the process of designing, preparing, running and analyzing an example
experiment. The example experiment represents a typical setup that you can use to
quickly familiarize yourself with a 7500 Fast system running AccuSEQ® Software.

Description The objective of the example Mycoplasma SEQ experiment (example experiment) is to
detect the presence of Mycoplasma species DNA in each test sample.

In the example experiment:

* DNA is extracted from samples using the PrepSEQ® Mycoplasma Nucleic Acid
Extraction Kit.

e The target is the bacteria being tested (mycoplasmas).

¢ Each reaction in the experiment contains multiple primer sets that are designed to
amplify the same target sequence from different species and SYBR® Green I dye
to detect the dsDNA products generated during PCR.

AccuSEQ® Software v2.0 Mycoplasma SEQ Experiments Getting Started Guide 15



Get Started

Reaction plate

About the example Mycoplasma SEQ experiment

The AccuSEQ® Software displays the 96-well reaction plate layout as shown below:

layout
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Chapter 1 Get Started 1
About the example Mycoplasma SEQ experiment

About the example  In this getting started guide, you will use two files:

experiment data * In Chapter 2, you will create an example Mycoplasma SEQ experiment that
files contains setup data, then you will save the file to your computer.

¢ In Chapter 5, you will view results in an example Mycoplasma SEQ experiment file
that contains run data. The data file for the example experiment installs with the
AccuSEQ® Software.

You can find the data file for the example experiment on your computer at

<drive>:\ Applied Biosystems\ AccuSEQ\ experiments\ Mycoplasma Presence Absence
Detection by MycoSEQ Example.eds, where <drive> is the computer hard drive on
which the AccuSEQ® Software is installed.

The experiments folder of the AccuSEQ® Software contains additional example files
for the Custom Experiments workflow that you can reference when analyzing your
own data. The following example files install with the AccuSEQ® Software:

* CHO residual DNA Quantitation Example.eds

¢ HCP Quantitation by ProteinSEQ Example.eds

* Mycoplasma Presence Absence Detection by MycoSEQ Example.eds
* Presence Absence Example.eds

* Residual Protein A Quantitation by ProteinSEQ Example.eds

Note: Be sure to use the Mycoplasma Presence Ab sence Detection by MycoSEQ
Example.eds file when you perform the procedures in this guide.

AccuSEQ® Software v2.0 Mycoplasma SEQ Experiments Getting Started Guide 17



1 Get Started
Example experiment workflow

Example experiment workflow

The figure below shows the workflow for the example Mycoplasma SEQ experiment.

Set up the experiment (Chapter 2)

¢ Create a new experiment.

e Define the experiment properties.

e Set up the samples and controls.
 (Optional) Review the run method.

e Print the experiment and reaction setup.

e Save the experiment.
Prepare the reactions (Chapter 3)

¢ Prepare the DNA template.
e Prepare the premix solution.
¢ Prepare the experiment plate.

Run the experiment (Chapter 4)

e Prepare for the run.

* (Optional) Enable the notification settings.
e Start the run.

* (Optional) Monitor the run.

¢ Unload the instrument.

18 AccuSEQ® Software v2.0 Mycoplasma SEQ Experiments Getting Started Guide



Chapter 1 Get Started 1
Example experiment workflow

Review the Results Summary (Chapter 5)

¢ Review the Results Summary.
e Export and print the data.

(Optional) Review the Results (Chapter 6)

¢ Review the Quality Summary.
¢ Review the Amplification Plot.
¢ Review the Melt Curve.

¢ Review the table data.

e Export and print the data.

(Optional) Investigate the Results (Chapter 7)

¢ Review the Multicomponent Plot.
* Review the Raw Data Plot.

¢ Review the analysis settings.

e Omit wells from the analysis.

AccuSEQ® Software v2.0 Mycoplasma SEQ Experiments Getting Started Guide 19
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Example experiment workflow

20 AccuSEQ® Software v2.0 Mycoplasma SEQ Experiments Getting Started Guide



Set up the experiment

B Chapter OVeIVIEW . . ...\t 21
Create anew experiment. ............. ... i 23
Define the experiment properties. . .......... ... .o 24
Set up the samples and controls. ............. .. ..o il 26
(Optional) Review therunmethod ................ ... ... .. o Lt 29
Print the experiment and reactionsetup....................... ... .. ..., 30
Finish the experimentsetup ................. 32

Chapter overview

This chapter explains how to use the SEQ Experiment workflow in the AccuSEQ®
Software to set up the example Mycoplasma SEQ experiment. The SEQ Experiment
workflow provides a step-by-step workflow for a specific Applied Biosystems SEQ
assay. The SEQ experiment workflow calculates reagent volumes, determines
optimum plate setup, guides you through experiment set up, uses optimized thermal
cycling conditions, and performs data analysis.

Note: An experiment you create in the SEQ experiment workflow cannot be accessed
from the custom experiment workflow. When you design your own experiments, you
can select alternate workflows (see “Using this guide with your own experiments” on

page 14).

About predefined settings

For the example experiment, the SEQ workflow guides you through Life Technologies
recommended best practices and demonstrates different result scenarios. You will
enter design parameters to set up, run, and analyze Mycoplasma experiment samples
prepared with the MycoSEQ™ Mycoplasma Real-Time PCR Detection Kit. Based on
the Mycoplasma SEQ assay you select, the following settings are pre-defined by the
software and are not editable:

¢ The experiment type is presence/absence.

* The run method includes three stages: holding, cycling, and melt curve.
® The reaction volume per well is 30 uL.

* SYBR® Green dye is the reporter dye.

* A minimum of one of each of the following sample types are included in the plate
layout: unknown sample, positive control, and negative control.

AccuSEQ® Software v2.0 Mycoplasma SEQ Experiments Getting Started Guide 21



2 Set up the experiment
For more information

For more information

For more information on:

Instrument — Refer to the Applied Biosystems 7500/7500 Fast Real-Time PCR System
Maintenance Guide.

SYBR Green reagents and PCR — Refer to the Applied Biosystems Real-Time PCR
Systems Reagent Guide.

Using the Custom Experiment workflow — Refer to the AccuSE Q®Software v2.0
Custom Experiments Quick Reference Card.

Example experiment workflow

The workflow for setting up an experiment similar to the example experiment

provided with this getting started guide is shown below.

22

Set up the experiment (Chapter 2)
v
Create a new experiment.
Define the experiment properties.
Set up the samples and controls.

(Optional) Review the run method.

g M DN~

v

Prepare the reactions (Chapter 3]

v

Run the experiment (Chapter 4)
v

Review the Results Summary (Chapter 5)
v

(Optional) Review the Results (Chapter 6)
v

(Optional) Investigate the Results (Chapter 7)
A 4

End experiment.

AccuSEQ® Software v2.0 Mycoplasma SEQ Experiments Getting Started Guide
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Chapter 2 Set up the experiment 2
Create a new experiment

Create a new experiment

Create a new experiment using the SEQ Experiment workflow in the AccuSEQ®
Software.

1. Double-click () (AccuSEQ® v2.0 Software).

2. Enter your user name and password, then click OK.

Note: See your system administrator for user name and password.

3. In the Home screen, click Create SEQ Experiment to open the SEQ Experiment
workflow.

AccuSEQ® Software v2.0 Mycoplasma SEQ Experiments Getting Started Guide 23



2 Set up the experiment
Define the experiment properties

4. In the SEQ assay selection dialog, verify that Mycoplasma Assay v2.0 is selected
from the presence/absence assay group, then click Next.

j Wéhich installed SEQ assayis) do you wantto run? @
a Select one or more availahle SEQ assays within an assay aroup. To select an assay from another

group, deselect all assays from the first group, then select from the new group. When you are
finished, click "Mext'

Presence/Bbsence

Assay Group

hycoplasima Assay w2 .0

| Mt == | Cancel

Note: The SEQ assays shown in this dialog may vary, depending on the valid SEQ
assays installed on your system.

Define the experiment properties

About the example
experiment

Complete the
Experiment
Properties screen

24

In the Experiment Properties screen, enter identifying information for the experiment,
and verify the assay information to use.

In the example Mycoplasma SEQ experiment:

* The experiment is identified as an example (Mycoplasma Presence Absence
Detection by MycoSEQ Example).

¢ The SEQ experiment type is presence/absence.

¢ The SEQ assay used is Mycoplasma Assay v2.0.

Note: The SEQ experiment workflow automatically specifies the setup information
(experiment type, reagents, targets) and an optimized run method for the selected
assay.

1. Click the Experiment Name field, then enter Mycoplasma Presence Absence
Detection by MycoSEQ Example Setup.

Note: The experiment header updates with the experiment name you entered.
2. Leave the Barcode field empty.
3. Click the Comment field, then enter Mycoplasma Presence Absence Detection

by MycoSEQ Example.

AccuSEQ® Software v2.0 Mycoplasma SEQ Experiments Getting Started Guide



Chapter 2 Set up the experiment 2
Define the experiment properties

4. Verify the SEQ experiment type and assay to use in the example experiment:

* SEQ Experiment Type - Presence/Absence. The SEQ experiment type
indicates the category of experiment automatically specified when you select

the SEQ assay to use. A SEQ presence/absence experiment detects the
amplification of targets.

IMPORTANT! The parameters for a SEQ presence/absence experiment are
customized for detection of specific organisms and species and may yield
different results than a custom presence/absence experiment.

* SEQ Assay(s) Used — Mycoplasma Assay v2.0. The SEQ assay used
indicates the organism detected by the assay.

5. Click Next.

Experiment: Mycoplasma Presence ... Assay: Mycoplasma Assay v2.0

Experiment Properties

a Enter an experiment name, enter a comment {optianal), then click "Mext" to continue.

How do you want to identify this experiment?

* Experiment Mame: | hMycoplasma Presence Absence Detection by MycoSEQ Example

2 Barcode (Optional):

3 Comment (Optional): | Mycoplasma Presence Absence Detection by MycoSEQ Example

SEQ Experiment Type: PresencefAbhsence
4 SEQ Assayis) Used:  Mycoplasma Assayv2.0

Guidelines for your =~ When you set up your own Mycoplasma SEQ experiment:

experiment  Enter an experiment name that is descriptive and easy to remember.
Note: The experiment name is used as the default file name.
¢ (Optional) Enter a barcode to identify the barcode on the reaction plate.
¢ (Optional) Enter comments to describe the experiment.
For more For more information on:
information .

Completing the Experiment Properties screen — Access the AccuSEQ® v2.0
Software Help by clicking @ or pressing F1.

* Mycoplasma experiments — Refer to the MycoSEQ® Mycloplasma Real-Time PCR
Detection Kit Protocol.
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Set up the samples and controls

Set up the samples and controls

About the example
experiment

Complete the
Sample Setup
screen

26

In the Sample Setup screen, enter the number of samples, replicates, and controls to
include in the reaction plate, enter the sample and control names, then select which
plot color to assign to each sample and control.

The AccuSEQ® Software uses the sample information that you enter in the Sample
Setup screen to fill the wells in the plate layout (see page 28) and to calculate the
required reaction component volumes for each sample type, based on the MycoSEQ
Mycoplasma Detection Kits User Guide guidelines.

The Mycoplasma Presence Absence Detection by MycoSEQ Example experiment uses:

Seven samples, where the presence/absence of the target (a mycoplasma
contaminant) is unknown.

One Inhibition Control replicate for all samples except Sample 3. Each Inhibition
Control replicate contains positive control template (Mycoplasma Real-Time PCR
DNA Control) and sample template. Running an inhibition control is
recommended for each unknown. Sample 3 demonstrates the new feature in
AccuSEQ 2.0 that enables the user to choose not to run the recommended
inhibitory control.

Two Positive Control replicates. Replicates contain positive control template
(Mycoplasma Real-Time PCR DNA Control) instead of sample template.

Two Negative Control replicates. Replicates contain water instead of sample
template.

. In the Mycoplasma Assay v2.0 column of the How many samples and controls do you

want to run? table, specify the number of samples and sample volume.

a. Specify the number of samples and replicates:

For Number of...t Enter...}
Samples 7
Sample replicates 1
Inhibition control replicates for each sample8 1
Positive control replicates 2
Negative control replicates 2

T At least one positive control, one negative control are required.
T The number that you specify is listed below in the sample type list (see step 2).

8§ A minimum value of zero is acceptable. One inhibitory control per reaction is
recommended but not required.

b. Set the Sample volume per reaction (2-10 uL) to 10.
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Set up the samples and controls

2. Verify the contents of the Define Samples for Assay: Mycoplasma Module v2.0 table:
a. Sample Names for samples with Sample Type = UNKNOWN:

e Samplel
e Sample 2
L4 oo
e Sample?7
Sarnple Tvpe Sarnple Mame |m Plot Color | Number of Wells - | Mumber of wells -
Sample Inhibition Controls
[ UnKMOwN Sample 1 - 1 1 it
0 Sample 2 - 1 1
0 Sample 3 - 1 0 i
[ kMo Sample 4 - 1 1 1
[ UnKMOwN Sample 5 - 1 1
[ RO Sample § - 1 1 m
0 Sample 7 - 1 1 |

b. Sample Names for samples with Sample Type = POS and NEG:
e POS1
¢ NEG1

c. Colors in the Plot Color drop-down lists.

Note: The plot color represents the amplification plot data in the software
and does not correspond to the dye color in the chemistry.

d. Specify the number of of inhibition controls assigned to individual samples
in the column Number of Inhibition Controls:

¢ In this example, change the number of inhibitory controls for Sample 3
from 1 to 0.

¢ In the table How many samples and controls do you want to run?, verify that
the cell for Number of inhibition control replicates for each sample changes
from the number 1 to the text VARIABLE, indicating a variable number
of inhibitory controls assigned to each samples.

Note: When you click a well, it becomes blank. If you did not mean to
change the well, press ESC to restore VARIABLE.

3. Click Next.
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Set up the samples and controls

View the plate The AccuSEQ® Software automatically selects locations for the wells in the reaction
layout plate based on the sample setup information you entered in the Sample Setup screen
(see page 26). You can view and edit the plate layout before starting an instrument run.
For the example experiment, use the following procedure to view the plate layout and
move pairs of samples to new well positions by swapping their well locations.

1. Click (Setup » Plate Layout) in the navigation pane, if not already selected.

2. Review the initial well selections in the Plate Layout screen. In the Mycoplasma
SEQ experiment, the wells are arranged as shown:

Groupvecl 5By GIlum s - gelext [ Szlectl. 7] [ Seerit. =] scizer -] Cizp o [Soictzd. |
"2 Chow - Ye s ¥ ‘ HET| Wiew Lzgen: i | o | Exs |
a 3 4 a 3} 7 g a -0 -1 -
Samale - Samole 2 Samale D Samole 4 Samoale 5 Samale & Samole T
1)
| [ my=eztnsn [ wy=oztnsn [0 wy=eiasn [ wyzeziaen [ wizeztasn [ Mimeziasn [ Mizosziasn
Eomalc Eomale X Eomalc 1 HEomale & Eomalc & Eomalc ¢
B e P L TR L T 1 L
I3
I
E
F
i
FMs | FOs 1 HF & | HF5 |
—|! @ wzomiasn [ Mimozimzn [] wmozrasn [ Mizeziasn
3 I Vaul . [H Unkrwn 7 LI Heaiyativg Corig ol 2 & Pueitivg Curiy ol 2 EE Intibitivn Cuntid @ 73 = ply

By default, the software:

* Groups Unknown sample and Inhibition Control replicates in columns,
starting with well Al.

* Assigns Positive Control and Negative Control replicates to the last well row
(wells H1-H12).
3. In the Wells pane, make sure there are:
¢ 7 Unknowns
¢ 6 Inhibition Controls
e 2 Positive Controls [
e 2 Negative Controls [.]
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Guidelines for your

experiment

For more
information

5.

Chapter 2 Set up the experiment 2
(Optional] Review the run method

Note: If the plate layout is incorrect, click Previous and check your entered
values.

(Optional) Review the run method (see page 29).

Note: The SEQ experiment workflow automatically specifies an optimized run
method for the selected assay.

Click Next.

When you set up your own Mycoplasma SEQ experiment:

Identify each sample with a unique name and color.

Enter the number of samples and controls to set up in the reaction plate.

IMPORTANT! Use at least one negative and one positive control per run. One
inhibition control per sample recommended but not required.

If the number of reactions required exceeds the number of wells in the reaction
plate, reduce the number of samples, Unknown replicates, Negative Control
replicates, Positive Control replicates, and/or Inhibition Controls.

IMPORTANT! A SEQ experiment provides a default plate layout. To modify the
default plate layout, refer to the Mycoplasma Real-Time PCR Detection Kit Protocol
for plate layout suggestions.

If you use Fast reaction tube strips (Part no. 4358293) for your reactions, a
maximum of 6 tube strips can be used in the 7500 Fast instrument (see page 43 for
reaction loading guidelines).

Enter a sample volume per reaction. Applied Biosystems recommends a sample
volume per reaction of 10 uL for Mycoplasma SEQ experiments. The 7500 Fast
system supports total reaction volumes from 10 to 30 uL.

For more information on completing the Sample Setup screen, access the AccuSEQ®
v2.0 Software Help by clicking @ or pressing F1.

(Optional) Review the run method

About the example
experiment

In the SEQ experiment workflow, the AccuSEQ® Software selects a thermal profile for
the instrument run that is optimized for the SEQ assay you select in step 4 on page 24.
You can review, but not edit, the pre-defined thermal profile in the Run Method screen.

Note: The SEQ experiment workflow automatically specifies the setup information
(experiment type, reagents, targets) and an optimized run method for the selected
assay.

For the Mycoplasma Presence Absence Detection by MycoSEQ Example experiment, the
pre-defined run method is optimized for use with the Mycoplasma v2.0 SEQ assay.
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Review the Run
Method screen

For more

information

Set up the experiment
Print the experiment and reaction setup

Click Run in the navigation pane, then click Run Method. The thermal

profile displays the holding, cycling, and melt curve stages shown below.

Run Method

Holding Stage 1

Cyeling Stage 1

Melt Curve Stage 1

Mumber of Cycles: |40
Enable AutoDelta
Starting Cycle: [2

@ Continuous ) StepAndHald

100 —|

0

95.0°C

95.0°C

10:00

00%

100%

00:15

60.0°C
0100

0%

95.0°C
00:15

01:00

Step 1

Step 1

Step 2

Step 1

Step 2

Step 3

95.0°C

Legend

Data Collection On Data Collection Off A AutoDelta On A AutoDelta Off

Note: For the example experiment, do not perform the run at this time.

For more information on the Run Method screen, access the AccuSEQ® v2.0 Software
Help by clicking @ or pressing F1.

Print the experiment and reaction setup

About the example

experiment

30

In the Print Experiment Setup screen, save and print the plate layout and the detailed
reaction setup instructions (the calculated volumes for preparing the samples, controls,

and PCR reactions) for the example experiment.

Based on the setup information you entered in the Sample Setup screen (see page 26),
the reaction setup instructions for the Mycoplasma Presence Absence Detection by
MycoSEQ Example experiment includes the following information:

* The SEQ assay type is Mycoplasma Assay v2.0.

* The reaction volume per well is 30 pL with a 10% excess.

* The reaction components are:

—  Power SYBR® Green PCR Master Mix (2X)

—  Mycoplasma Real-Time PCR Primer Mix (10X)
— Muycoplasma Real-Time PCR DNA Control (positive control)
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— Negative Control (water)
— Unknown sample DNA
¢ Volume for all samples:
— The premix solution volume per well is 18 pL.

— The final sample and control volume per well is 12 uL.

Print the Print the experiment setup (plate layout and detailed reaction setup instructions) for
experiment setup the example experiment, then save the instructions for Chapter 3.

1. Click Setup in the navigation pane, then click |52 Print Experiment Setup.

2. In the Print Experiment Setup screen, select the elements to include in the report:
¢ Reaction Setup Instructions

e Detailed Instructions

¢ Plate Layout

Print Experiment Setup

a Select the parts ofthe experiment setup to include. You can preview, save a5 a PDF, and print the selected contents. Click "MNexd" to cantinue.

What parts of the experiment setup do you want to include?

An Experiment Summary is included in every report. This includes experiment name, experiment type, assay, username,
run information, analysis settings, etc. You can select additional parts helow.

Reaction Setup Instructions  Awork sheet containing the component volurmes needed for the number of samples and
contrals specified.

@ Summary Instructions Summary instructions provide component volumes.
() Detailed Instructions  Detailed instructions provide step-hy-step instructions and component volumes,

Flate Layout An illustration of the wells in the reaction plate. Indicates the assay and sample assigned to
each well

3. Click Print to print the report, or click Preview to display the report on-screen.

4. Specify a reason for change, if prompted. For more information, see “Security,
Audit and E-Signature (SAE) for users” on page 87.

5. Set the printed reaction setup instructions aside until you prepare the reactions

(see page 35).
For more For more information on printing the plate layout and reaction setup instructions,
information access the AccuSEQ® v2.0 Software Help by clicking @ or pressing F1.
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Finish the experiment setup

Finish the experiment setup

To finish the experiment setup, select a save option.

—

Camputer

Metwwork

32

My Documents

A

.

Save the 1. At the bottom of the AccuSEQ® Software screen, click Save & Finish.
experiment 2. In the Save Experiment dialog box, verify the Mycoplasma Presence Absence
Detection by MycoSEQ Example.eds file name, then click Save.
j Save
Save in: | | experiments - |EI|E1|E||E|
Ej CHO residual DA Quantitation Example.eds
;L ;j HCP Quuantitation by ProteinSEGQ Example.eds
e e ;j Mycoplasima Presence Absence Detection by MycoSEQ Example.eds
jj Presence Absence Example.eds
! ;j Residual Protein A Quantitation by ProteinSEQ Example.eds
Desktop

File name: Mycoplasma Presence Absence Detection by MycoSEQ Example.eds | Save |7 2

Files oftvne:  |Experiment Document Single files *.eds) - | Cancel |

3. Specify a reason for change and sign the experiment, if prompted. For more
information, see “Security, Audit and E-Signature (SAE) for users” on page 87.

4. By default, the example experiment is saved to the
<drive>:\ Applied Biosystems\ AccuSEQ\ experiments folder, and you are
returned to the Run Method screen. For the example experiment, do not perform
the run at this time.

To continue with:
¢ Examining the results of the example experiment, go to Chapter 6.

¢ Instructions for running your own Mycoplasma SEQ experiment using the
example experiment as a guide, go to Chapter 3.
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Finish the experiment setup

Guidelines for your  When you finish your own Mycoplasma SEQ experiment:

experiment e In the SEQ Experiment screen, select the appropriate save option:
Select/Click To...

File » Save Save the experiment using the current file name and

lor | in the toolbar) save location.

File » Save As... Save the experiment using a new file name and save
location.

File » Save as Template... Save the experiment as an SEQ template (*.edt file
typel.

Save & Finish Save the experiment without making any further
changes and prepare to start the run.

* By default, experiments are saved to:
<drive>:\ Applied Biosystems\ AccuSEQ\ experiments
To change the:

— Save location for a specific experiment — Navigate to the desired location
using the Save Experiment dialog box.

— Default save location — Select Tools » Preferences, then select the Defaults
tab. In the Data Folder field, browse to then select the desired location.

IMPORTANT! Do not open, edit, or manipulate the experiment files stored on the
hard drive of the computer outside of AccuSEQ® Software v2.0. If you do so, you
will corrupt the experiment file and you will not be able to open it in AccuSEQ®

Software v2.0.

For more For more information on using SEQ templates, see “SEQ template workflow” on
information page 90.
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Prepare the reactions

Chapter OVerview . . ... 35
Preparethe DNA template . . ......... .. .. i 36
Prepare the premix solution .......... ... ... .. .. i il 36
Prepare the experiment plate . .......... ... ... i 37
Guidelines for your experiment.............. ... i, 38

This chapter explains how to prepare the PCR reactions for the example Mycoplasma
SEQ experiment and provides guidelines for preparing the PCR reactions for your
own Mycoplasma SEQ experiment.

Example The workflow for preparing the PCR reactions for the example experiment is shown
experiment on page 35:
workflow

Start experiment
v
Set up the experiment (Chapter 2)
v
Prepare the reactions (Chapter 3)
¢ Prepare the DNA template.
e Prepare the premix solution.
e Prepare the experiment plate.
v
Run the experiment (Chapter 4)
v
Review the Results Summary (Chapter 5)
v
(Optional) Review the Results (Chapter 6)
v
(Optional) Investigate the Results (Chapter 7)
v

End experiment
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3 Prepare the reactions
Prepare the DNA template

Prepare the DNA template

About the example
experiment

Required materials

Prepare the
template

In this section, prepare the DNA template for the PCR reactions using the PrepSEQ®
Mycoplasma Nucleic Acid Extraction Kit.

For the example Mycoplasma SEQ experiment, the template for the PCR reactions is
DNA extracted from bacteria found in test samples. There are 7 test samples to analyze
for the presence or absence of mycoplasma bacterial contaminants.

 The PrepSEQ® Mycoplasma Nucleic Acid Extraction Kit for DNA isolation.

* Media, cell culture, or other source that you are testing for the presence of
mycoplasmas.

Refer to the PrepSEQ® Mycoplasma Nucleic Acid Extraction Kit Protocol for details on
DNA isolation.

Prepare the premix solution

About the example
experiment

Required materials

36

Prepare the premix solution using the components and volumes that were calculated
by the AccuSEQ® Software (see page 30). For a Mycoplasma SEQ experiment, you
prepare a premix solution that contains multiple primers designed to amplify the
mycoplasma targets and a reagent to detect amplification of the targets.

Note: The premix solution includes all components except Unknown sample, Positive
Control DNA and Negative Control (water).

All samples contain the same primers for the bacterial target (mycoplasmas); therefore,
only one premix solution is required.

The premix solution components and volumes calculated in the software (without
overage) are:

Component Volur;:a[cplli.:r:or !
Power SYBR® Green PCR Master Mix (2X) 15.0
Mycoplasma Real-Time PCR Primer Mix (10X] 3.0
Total Premix Solution Volume 18.0

Note: The sample is not added at this time.

* Premix solution components (listed above)
* Microcentrifuge tubes

¢ Dipettors

¢ DPipette tips

e Vortexer

¢ Centrifuge
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Prepare the premix  For the following hazard, see the complete safety alert descriptions in Appendix B on
solution page 91.

WARNING! CHEMICAL HAZARD. Power SYBR® Green PCR Master Mix. A

M LD

Thaw all kit reagents completely.
Vortex, then spin down the reagents.
Label an appropriately sized tube for the premix solution: Premix Solution.

Prepare the premix solution according to the following table.

IMPORTANT! Use a separate pipette tip for the Power SYBR® Green PCR Master
Mix and the Mycoplasma Real-Time PCR Primer Mix.

Component Volume (pL) for 17 Reactionst
Power SYBR® Green PCR Master Mix (2X) 280.5

Mycoplasma Real-Time PCR Primer Mix (10X) 56.1

Total Premix Solution Volume 336.6

T Includes 10% excess to compensate for pipetting errors.
Mix the premix solution by gently pipetting up and down, then cap the tube.
Centrifuge the tube briefly.

Place the premix solution on ice until you prepare the reactions.

Prepare the experiment plate

In this section, prepare all reactions in a 96-well plate; use the volumes that were
calculated by AccuSEQ® Software v2.0 (see page 30).

About the example  For the example Mycoplasma SEQ experiment:

experiment .
[ ]

Required materials

A MicroAmp® Fast Optical 96-Well Reaction Plate is used.
The reaction volume is 30 uL per well.

The reaction plate for this example contains 7 Unknowns, 6 Inhibition Controls,
2 Positive Controls, and 2 Negative Controls.

The total volume of each reaction is 30 pL.

MicroAmp® Fast Optical 96-Well Reaction Plate, also called a Fast reaction plate
(Part no. 4346906)

MicroAmp® Optical Adhesive Film (Part no. 4311971)
Premix solution (see page 36)

Unknown sample DNA

Mycoplasma Real-Time PCR DNA Control (Positive Control)

Negative Control (water)
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-_

Prepare the
reactions

o M Wb

10.
11.
12.

Microcentrifuge tubes
Pipettors

Pipette tips

Vortexer

Centrifuge

. Label one MicroAmp® Fast Optical 96-Well Reaction Plate with an appropriate

name or barcode.

Add 18.0 uL of premix solution to each well

Add 12.0 uL of water to each Negative Control sample well.
Add 2 uL of water to each Unknown sample well.

Add 10 pL of water to each Positive Control well.

Note: Do not add water to the Inhibition Controls.

Add 10 pL of sample to the appropriate Unknown sample and Inhibition Control
wells.

Completely thaw the Mycoplasma Real-Time PCR DNA Control (Positive
Control). Life Technologies recommends thawing the Positive Control at 37 °C for
five minutes to ensure consistent results.

Vortex, then spin down the Positive Control.

Add 2.0 pL of Positive Control DNA to each Inhibition Control and Positive
Control well.

Mix each sample by gently pipetting up and down.
Seal the plate with MicroAmp® Optical Adhesive Film.

Briefly centrifuge the reaction plate.

Guidelines for your experiment

Reaction When you prepare your own Mycoplasma presence/absence reactions:

preparation .
guidelines

38

Include excess volume in your calculations to compensate for the loss that occurs
during reagent transfers.

Include all required components.

Keep the Power SYBR® Green PCR Master Mix (2X) protected from light, in the
freezer, until you are ready to use it. Excessive exposure to light may affect the
fluorescent SYBR® Green I dye.

Prior to use:

— Thoroughly mix the master mix by briefly vortexing, then centrifuging the
tube.

— Resuspend the primer mix by vortexing, then briefly centrifuge the tube.
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— Thaw the Positive Control DNA at 37 °C for 5 minutes, then vortex and
centrifuge to ensure consistent results.

— Thaw frozen samples by placing them on ice. When thawed, resuspend the
samples by vortexing, then briefly centrifuge the tubes.

Experiment When you prepare your own Mycoplasma SEQ experiment:
preparation » Wear appropriate protective eyewear, clothing, and gloves.
guidelines .

Make sure you use the appropriate consumables. If you use:

— TFast reaction plates (Part no. 4346906) — Seal the reaction plate with optical
adhesive film (Part no. 4311971)

— Fast reaction tube strips (Part no. 4358293) — Cover the tubes with optical
caps (Part no. 4323032)

¢ Make sure the arrangement of the PCR reactions matches the plate layout in the
AccuSEQ® Software. You can either:

— Accept the plate layout automatically generated by the AccuSEQ® Software.
or

— Use the Swap and Click-Drag controls available in the Plate Layout screen to
move samples to new well positions in the plate layout.

¢ If you use optical adhesive film, seal each reaction plate as follows:

a. Place the reaction plate onto the center of the 96-well base (Part
no. N8010531).

b. Load the reaction plate as desired.

c. Remove a single optical adhesive film (film) from the box.

Fold back one of the end-tabs. Hold the film with its
backing side up.

d. In one continuous movement, peel back the white
protective backing from the center sealing surface. Do
not touch the center sealing surface.

IMPORTANT! Improper peeling of the optical adhesive

film may result in haziness, but it does not affect results. Haziness
disappears when the film comes into contact with the heated cover in the
instrument.

e. While holding the film by the end-tabs, lower the film
onto the reaction plate (adhesive side facing the reaction
plate). Be sure the film completely covers all wells of the
reaction plate.

f. While applying firm pressure, move the applicator
(Part no. 4333183) slowly across the film, horizontally
and vertically, to ensure good contact between the film
and the entire surface of the reaction plate.
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For more
information

40

place, grasp one end of the end-tab and pull up and

g. While using the applicator to hold the edge of the film in -
away sharply. Repeat for the other end-tab. /

h. Repeat step f to ensure a tight, evaporation-free seal. N
While applying firm pressure, run the edge of the :
applicator along all four sides of the outside border of
the film.

Note: Optical adhesive films do not adhere on contact. The films require the
application of pressure to ensure a tight seal.

i. Inspect the reaction plate to be sure all wells are sealed. You should see an
imprint of all wells on the surface of the film.

For more information on:

Consumables — Refer to the Applied Biosystems 7500/7500 Fast Real-Time PCR
System Maintenance Guide.

Using Swap and Click-Drag controls to change the plate layout — Access the
AccuSEQ® v2.0 Software Help by clicking @ or pressing F1.
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B Chapter OVeIVIEW . . ...\t 41
B Preparefortherun.............. .. 42
B (Optional) Enable the notification settings................................ 44
B Starttherun............ ... 45
B (Optional) Monitortherun.......... ... i 46
B Unload theinstrument. ............ ... i 50

Chapter overview

This chapter explains how to perform a run on the Applied Biosystems 7500 Fast Real-

Time PCR System.
Example The workflow for running the example experiment is shown on page 42.
experiment
workflow
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Prepare for the run

Start experiment
v
Set up the experiment (Chapter 2)
v
Prepare the reactions (Chapter 3)
v
Run the experiment (Chapter 4)
v
Prepare for the run.
(Optional) Enable the notification settings.
Start the run.
(Optional) Monitor the run.

a M 0 bdh -

Unload the instrument.

v

Review the Results Summary (Chapter 5)
v

(Optional) Review the Results (Chapter 6)
v

(Optional) Investigate the Results (Chapter 7)
A 4

End experiment

Prepare for the run

Open the example
experiment

42

Before you run the experiment, calibrate the 7500 Fast instrument. Refer to the Applied
Biosystems 7500/7500 Fast Real-Time PCR System Installation Guide (Pub. no. 4387788) or
the AccuSEQ® Software Help.

Prepare for the run by opening the example experiment file you created in Chapter 2,
then loading the sealed reaction plate into the 7500 Fast instrument.
1. Double-click ‘g (AccuSEQ® v2.0 Software).

2. Enter your user name and password, then click OK.

Note: See your system administrator for user name and password.
3. In the Home screen, click Open Experiment.

4. In the Open dialog box, navigate to the experiments folder (default):
<drive>:\ Applied Biosystems\ AccuSEQ\ experiments

5. Double-click Mycoplasma SEQ Example Setup.eds to open the example
experiment file you created in Chapter 2.
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Prepare for the run

Load the reaction CAUTION! PHYSICAL INJURY HAZARD. During operation, the sample C
plate into the block can be heated to 100 °C. Before performing the following procedure, be
instrument sure to wait until the sample block reaches room temperature.

IMPORTANT! Wear powder-free gloves when you handle the reaction plate.

1. Push the tray door to open it.

2. Load the plate into the plate holder in the instrument with the notched Al

position at the top-left of the tray. Ensure that the plate is properly aligned in the
holder.

3. Push the tray door to close it. Apply pressure to the right side of the tray door at
an angle.

Guidelines for your  IMPORTANT! Standard reaction plates and tube strips will not properly function and
experiment might be crushed when using the Fast sample block.
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(Optional) Enable the notification settings

When you load the reactions into the instrument, if you use:

Fast reaction plates — Place the reaction plate in the plate holder with well Al at
the back-left corner.

Fast reaction tube strips — Place the tube strips in the plate holder for tube strips.

Note: For optimal performance with partial loads on a 7500 Fast instrument:

* Place empty tube strips in columns 1 and 12 to prevent crushing of tubes
containing samples.

* Place tube strips with samples in the plate holder vertically, starting in
columns 6 and 7 and moving outward.

* A maximum of 6 tube strips can be used in the 7500 Fast instrument. Leave
columns 2, 3, 10, and 11 empty.

Reaction tubes — Place the tubes in the plate holder.

IMPORTANT! Do not use MicroAmp® Fast Reaction Tubes (Part no. 4358297) in
the 7500 Fast system.

(Optional] Enable the notification settings

About the example
experiment

Set up notifications

44

Enable the notification settings so that the AccuSEQ® Software sends you e-mail when
the 7500 Fast instrument begins and completes the run, or if an error occurs during the
run. Enabling the notifications settings feature is optional and does not affect the
performance of the 7500 Fast system or the duration of the run.

IMPORTANT! The notification settings feature is available only if the computer that you
are using is running the 7500 Fast instrument and is connected to an Ethernet network.

Note: Run notifications are saved per user.

In the example experiment:

-_

The AccuSEQ® Software is set up to send notifications when the 7500 Fast system
ends the run and if it encounters any errors during operation.

The example outgoing mail server (SMTP) is not set up for secure sockets layer

(SSL) encryption and does not require authentication for use.

Click Wi Run in the navigation pane, then click D Notification Settings.
—

Select Yes to Enable Notifications.

Select the events that will trigger notifications:
¢ Instrument Error

¢ Run Completed

Enter e-mail addresses for notifications.
For example: scientist@mycompany.com.

Note: Separate addresses with a comma (,).

Set the outgoing mail server settings:
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Chapter 4 Run the experiment
Start the run

a. Enter the name of the Outgoing Mail Server (SMTP).

For example: smtp.mycompany.com.

b. Leave the default Outgoing Mail Server Port Number (25).

6. Set the server authentication settings:

a. Select No for Server requires an encrypted connection.

b. Select No for Server requires authentication.

Notification Settings

]
Enahle Motifications: & Yes (O Mo
Select the events to generate notifications: Instrurnent Errar
[] Run Started

Run Completed

Enter e-mail addresses for notifications: | scientist@mycompany.com
Separate e-mail addresses with commas.
For example: user! @domaint.com, user@domain2.com

‘ Qutgaoing Mail Server (SMTP): | smip mycompany cam

Far example: smtp.mycampany.com

Outgaing Mail Server Port Mumber: |25
Faor exarnple: 25

E&Ner requires an encrypted connection? Oes @ MNo

Server requires authentication? O ves B Nao

Guidelines for your =~ When you set up the 7500 Fast system for automatic notification:

experiment * Your system must be set up for network use. Refer to the Applied Biosystems 7500/
7500 Fast Real-Time PCR System Maintenance Guide.

¢ Contact your systems administrator or information technology department if you
need:

Start the run

E-mail addresses for users who will receive notifications

A network address for a simple mail transfer protocol (SMTP) server on the
LAN

A port number for the server, if different from the default (25)
A user name and password for the server, if required for access
The Secure Sockets Layer (SSL) setting of the server (on or off)

IMPORTANT! While the 7500 Fast instrument is performing a run, do not create
experiments, perform maintenance, print experiment data, or allow the computer to
run antivirus software or to enter hibernation mode. Performing such activities while
the instrument is running an experiment causes gaps in data collection.
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4 Run the experiment
(Optional] Monitor the run

To start your 7500 Fast instrument:
1. Click % Run in the navigation pane.
2. Click START RUN [§ at the top of any run screen.

3. Specify a reason for change, if prompted. For more information, see “Security,
Audit and E-Signature (SAE) for users” on page 87.

[Optional) Monitor the run

You can view the progress of the run in real time as described below. During the run,
periodically view all three available plots (Amplification, Melt Curve, Temperature)
from the AccuSEQ® Software for potential problems.

To... Action

Stop the run 1. In the AccuSEQ® Software, click STOP RUN.
2. In the Stop Run dialog box, click one of the following:
¢ Stop Immediately to stop the run immediately.

 Stop after Current Cycle/Hold to stop the run after
the current cycle or hold.

¢ Cancel to continue the run.

IMPORTANT! You cannot resume a run after you stop it.

View amplification data in Select M Amplification Plot.

real time See “About the Amplification Plot screen” on page 46.

View the melt curve in real | Select Melt Curve.

time See “About the Melt Curve screen” on page 48.

View the temperature plot Select Temperature Plot.
during the run

View progress of the run in | Select b Run Method.

the Run Method screen See “About the Run Method screen” on page 49.

Enable/disable notifications | Select or deselect Enable Notifications.
in the Notification Settings

See “(Optional] Enable the notification settings” on page 44.
screen

Note: You cannot change the sample setup or plate layout during a run.

About the The screen displays sample amplification (reporter signal) as your instrument collects
Amplification Plot fluorescence data during a run. If a method is set up to collect real-time data, the
Amplification Plot screen displays the data for the wells selected in the Plate Layout
tab. The plot contrasts the change in normalized reporter signal (ARn) and cycle
number. The Amplification Plot screen as it appears during the example experiment is
shown on page 47.

screen
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(Optional] Monitor the run

Amplification Plot

£ p alE =

Amplification Plot (ARn vs Cycle)

AR

0.001

0.0001

0.00001

0.000001 T ! : : : r . : : : r . . — . : : i
2 4 & & W0 12 4 1§ 18 ™ = M H A W W M X B/ 4
Cycle

Plot SeﬂingsT Options T Plot Legend ]

Plot Type: |&Rn vs Cycle v: Graph Type: |Log v: Flat Calar: el v:

Save current plot settings as the default for this experiment

To view data in the Amplification Plot screen, select the wells to view in the Plate
Layout tab.

The Amplification Plot screen is useful for identifying and examining abnormal
amplification. Abnormal amplification can include the following;:

* Increased fluorescence in negative control wells.

* Absence of detectable fluorescence at an expected cycle (determined from
previous similar experiments run using the same reagents under the same
conditions).

If you notice abnormal amplification or no signal in a well, troubleshoot the error as
explained in the AccuSEQ® v2.0 Software Help (click @ or press F1).
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4 Run the experiment
(Optional] Monitor the run

About the Melt
Curve screen

48

The melt curve screen displays sample amplification products (reporter signal) as your
instrument collects fluorescence data during a melt curve run, at the end of the cycling
stage. If a method is set up to collect melt curve data, the Melt Curve screen displays
the data for the wells selected in the Plate Layout tab. The plot contrasts reporter
signal (Rn) and temperature ( °C). The Melt Curve screen as it appears during the
example experiment is shown below:

N

a g & =
Meilt Curve (Derivative Reporter)

Derivative Reparter (-Rn)

Temperature (°C)

Plot Settings | Plot Legend

Flot Tyne: Derivative Reporter - | Target [l ~ | Calor el -

Save current plot settings as the default far this experiment

To view data in the Melt Curve screen, select the wells to view in the Plate Layout tab.

The Melt Curve provides the melting temperature (T,,) of each target (Target T,,,). The
T, information is used by the AccuSEQ® Software, along with the cycle threshold (Cr)
and the derivative signal, to define the presence or absence of mycoplasma in the
Unknown sample.

The Melt Curve screen is also useful for identifying and examining non-specific
amplification. Non-specific amplification can include the following:

* Increased fluorescence in negative control wells.

* A melting temperature in the no-target range (No Target T ,,).

If you notice non-specific amplification, troubleshoot the error as explained in the
AccuSEQ® v2.0 Software Help (click @ or press F1).
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(Optional] Monitor the run

About the Run The screen displays the run method selected for the run in progress. The software
Method screen updates the Run Status field and displays progress bars throughout the run.

For Mycoplasma SEQ experiments:

* A pre-defined run method is used and cannot be edited.

* During the third stage, there is a delay between melting and completion of the
third stage while the system analyzes the data.

* The Results Summary displays after the run is complete (see Chapter 5).

The figure below shows the Run Method screen as it appears in the example

experiment.
Run Method
Halding Stage Cycling Stage Melt Curve Stage
Mumber of Cytles: Continuous StepaAndHold

Enable AutoDelta

Starting Cycle

00 —

95.0"C 95.0°C 95.0"c 95.0°C

10:00 100%  oos

75—

Joo% 01:00 01:00

a0 —

25 —|

Step 1 Step 1 Step 2 Step 1 Step 2 Step 3

<

Legend
Data Collection On Data Collection OF A AutoDeltaOn A AutoDelta OF

If an alert appears, click the error for more information and troubleshoot the problem
as explained in the AccuSEQ® v2.0 Software Help (click @ or press F1).
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4 Run the experiment
Unload the instrument

Unload the instrument

Unload the reaction
plate

50

When your 7500 Fast system displays the Run Complete message, unload the reaction
plate from the instrument.

Note: When the instrument completes a run, the system saves the details of the run to
the instrument log.

CAUTION! PHYSICAL INJURY HAZARD. During operation, the sample
block can be heated to 100 °C. Before performing the following procedure, be
sure to wait until the sample block reaches room temperature.

IMPORTANT! Wear powder-free gloves when you handle the reaction plate.

1. Push the tray door to open it.
2. Remove the reaction plate.

3. Push the tray door to close it.

4. Discard the reaction plate as appropriate.
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Chapter overview

The AccuSEQ® Software automatically analyzes your data using information from the
instrument run. This chapter explains how to review the analysis results for the
example experiment using the Results Summary screen and how to export and print
data. If you receive questionable results, Chapter 6 explains how to further review the
results.

See “Navigation tips” on page 89 for information on navigating within the analysis
results screens.

Example The workflow for reviewing the example experiment data provided with this getting
experiment started guide is shown below.
workflow

Start experiment

v
Set up the experiment (Chapter 2)
v
Prepare the reactions (Chapter 3)
v
Run the experiment (Chapter 4)
v
Review the Results Summary (Chapter 5)
1. Review the Results Summary.
2. Export and print the data.
v

(Optional) Review the Results (Chapter 6)
v

(Optional) Investigate the Results (Chapter 7)
v

End experiment
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Review the Results Summary
About the analysis results

About the analysis results

About the analysis

About the example
experiment

52

Immediately after the instrument run is complete, the AccuSEQ® Software
automatically analyzes the SEQ experiment data using pre-defined analysis settings
optimized for the selected SEQ assay, then displays presence/absence calls in the
Results Summary on your computer.

The AccuSEQ® Software automatically analyzes the example experiment data using
the default analysis settings for the mycoplasma target. To view the example
Mycoplasma SEQ experiment results, open the data file that installs with the AccuSEQ®
Software. The data file was created with the same design parameters that are provided
in Chapter 2, then run and analyzed on a 7500 Fast system.

You can find the data file for the example experiment on your computer:
1. Double-click () (AccuSEQ® v2.0 Software).
2. Enter your user name and password, then click OK.
Note: See your system administrator for user name and password.
3. In the Home screen, click Open Experiment.

4. In the Open dialog box, navigate to the experiments folder (default):
<drive>:\ Applied Biosystems\ AccuSEQ\ experiments

5. Double-click Mycoplasma Presence Absence Detection by MycoSEQ
Example.eds to open the example experiment data file.

Note: The experiments folder contains several data files; be sure to select
Mycoplasma Presence Absence Detection by MycoSEQ Example.eds.

6. Select Results in the navigation pane to view the run results.

Results Summary

B Usethe Call Summary, Flate Layout and Table viewo feview exgeriment resuls. To view sample information and results, place the pointer on a well position

Call Summary

Pasitive Controls 1@ Pass 0 € Fail
Negative Controls: 1@ Pass 0 € Fail
Unknowns: 1@ Present 2 @ Absent 2 (4 Review 2 @ Fail
Plate Layout | Table View
Select |- Selectt.. > | [ Selectit. | FSelectit. —| | Y [Display: [l |
| 87 showinwells ¥ | FL view Legend ‘ | | |
1 2 3 4 5 3 7 8 E i 1 1z
Sample 1 Sample2 s Gample 4 i Sample B Sample 7
A @ - (%] 7
0
Cros 715 Crar a0 Crarars o Srzn70 traas
Sample 1 Sample 2 Sample 4 s Sample Sample 7

lIC| 1C|
Cr: 25260 Cr:25735 Cr. 24.888 Cr.24527

POS 1 POSs 1 HEG 1 NEG 1

Cr:25.748 Gr:37 571

Cr.3883 Gr.268.511
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Chapter 5 Review the Results Summary 5
Review the Results Summary

Guidelines for your =~ When you review your own Mycoplasma SEQ experiment:
experiment * Open a Mycoplasma SEQ experiment that contains run data.
* Review the run results in the Results Summary (see page 53).

Note: If a well is incorrectly identified when you review results (for example, you
pipetted Sample 1 into the well labeled as Sample 2), you can move samples to the
correct well positions, then re-analyze. See the AccuSEQ® v2.0 Software Help for
more information.

* (Optional) To further review results, view the Quality Summary (see page 59).

Review the Results Summary

Use the Call Summary, Plate Layout and Table views in the Results Summary screen to
review the experiment results.

About the example  The presence/absence calls for the samples in the example Mycoplasma SEQ experiment
experiment are:
e 7 Unknowns m — 1 Present, 2 Absent, 2 Review, 2 Fail

¢ 6 Inhibition Controls — 5 Pass, 1 Fail
* 2 Positive Controls [&] - 1 Pass, 1 Fail
2 Negative Controls [ ]| - 1 Pass, 1 Fail

For presence/absence call definitions, see page 53.

IMPORTANT! The Mycoplasma SEQ experiment performs a presence/absence assay. The
SEQ presence/absence assay is customized for detection of specific organisms and
species and may yield different results than a custom presence/absence assay.

Review the The Call Summary at the top of the Results Summary screen lists a summary of results
Call Summary for the wells in the reaction plate.

1. From the navigation pane, select B#8 Results » [E£| Results Summary.

2. Review the Call Summary for results:

Sample Type catlt Description
Positive Control €) Pass Target detected
€ Fail No target detected (target should be detected)
Negative Control @ Pass No target detected
@ Fail Target detected (no target should be detected)
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Review the Results Summary

Review the Results Summary

Sample Type callt Description

Unknown @ Present Target signal is present and is within the
temperature range, derivative range, and Cy
range for the assay.

€ Fail No target signal detected.

e Absent Target signal is not present within the
temperature range, derivative range, and Cy
range for the assay.

+) Review AccuSEQ® Software is unable to determine a
result.

t Causes of a fail or review result are displayed in the Results Summary (see step 3 on page 55) and the
Quality Summary (see page 59).

Review the results Use the Plate Layout to display Mycoplasma SEQ assay presence/absence calls, and to
in the plate layout select the data displayed in the Table View.

1. Select the Plate Layout tab in the Results Summary screen. The plate layout
displays call information about each well in the reaction plate in an illustration

(@ 0 0 @ o)

1 Piate Layout I Table View }
Select [Sample .. | = =]
| ElShuwinWellsv | ViewLegend
1 | 2 | E \ 4 5 6

Sample 1 Sample 1 Sample 1 Sample 1
‘o m
g Sample 2 Sample 2 Sample 2

m m

Sample 3 Sample 3 Sample 3 Sample 1 Sample 9

“|m m

2. In the Select Wells With drop-down list, select Sample Type, =, then Inhibition
Control. The AccuSEQ® Software selects the associated wells in the Plate Layout.

Select. [Sample ... j = j - Select It...j Display: [All J
Select ltem -
LInknown
Fasitive Cantrol
= = MHegative Contral

Inhikition Cantrol

While not present in the example experiment, an inhibition control (IC) well can
display a Review result ({% ), indicating that inhibitors are present in the
unknown sample.
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Export and print the data

3. To display the call assessment for an fail or review result, place the mouse pointer
on a well. For the example experiment, display wells: A1, A2, B1 and B2. The call

assessment for well A1 is shown below.

1 2 [ 3
Sample 1 Sample 1 Sample 1

A £ 1
CT: 27 BS Cr:27 521 CT:27.378
Sanl yyall: Al 2
g Sample Name: Sample1
Sample Type:  Unknown .
Cr: 27 763
— Call: Review 3
sam Call Assessment: All positive controls failed:
c Cr: 27.68
m Assay: Mycoplasma Assay v2.0
TTTITT

4. (Optional) To further review fail or review results, view the Quality Summary
(see page 59).

Review the results  Use the Table View to select, group or sort the results data for each well in the reaction

in the table view plate (see page 70).

Export and print the data

You can publish the experiment data in several ways:
¢ Export data
* Print the plate layout
* Create a slide of the plate layout

¢ Print a report

For information on performing these procedures, access the AccuSEQ® v2.0 Software

For more
Help by clicking @ or pressing F1.

information
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Export and print the data
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Review the results

Chapter OVerview . . ...
About the analysisresults.......... .. ... oo i i
Review the Quality Summary .............. .. .. i i
Review the Amplification Plot.................... .. ... .. ...
Review the Melt Curve ............. i
Review the tabledata.......... ... . . i

Exportand printthedata .............. ... ... ...l

Chapter overview

Example
experiment
workflow

In addition to reporting the presence/absence calls in the Results Summary
immediately after an instrument run completes, the AccuSEQ® Software provides a
call assessment and troubleshooting information for any questionable results in the

Quality Summary. This chapter explains how to further review the analysis results of
the example experiment using the Quality Summary and several of the plot analysis

screens, and how to export and print data. If further investigation is required,
Chapter 7 explains how to review the remaining plots and the analysis settings.

See “Navigation tips” on page 89 for information on navigating within the analysis
results screens.

The workflow for reviewing the analysis results for the example experiment data
provided with this getting started guide is shown below.
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Review the results
About the analysis results

Regulatory/restriction statement, if required

Start experiment
v
Set up the experiment (Chapter 2)
v
Prepare the reactions (Chapter 3)
v
Run the experiment (Chapter 4)
v
Review the Results Summary (Chapter 5)
v
(Optional) Review the Results (Chapter 6)
1. Review the Quality Summary.
2. Review the Amplification Plot.
3. Revew the Melt Curve.
4. Review the table data.
5. Export and print the data.
v
(Optional] Investigate the Results (Chapter 7)
v

End experiment

About the analysis results

About the results

About the example
experiment

Guidelines for your
experiment

58

The Quality Summary provides a call assessment description and troubleshooting
information for any review or fail results shown in the Results Summary. Use the
Quality Summary table, the Amplification Plot and Melt Curve screens, and the Table
View tab to review the call assessments for the plate.

To review the Mycoplasma Presence Absence Detection by MycoSEQ Example experiment
results, open the data file that installs with the AccuSEQ® Software (see page 17). For
the example experiment, investigate the results for wells: A2 and A5.

When you review the results for your own Mycoplasma SEQ experiment:
* Open a Mycoplasma SEQ experiment that contains run data.
* Review the run results in the Results Summary (see Chapter 5).

¢ Review questionable results using the Quality Summary (see page 60), then
review the appropriate plots (see page 61).

* (Optional) To further investigate questionable results, see Chapter 7.

AccuSEQ® Software v2.0 Mycoplasma SEQ Experiments Getting Started Guide



Regulatory/restriction statement, if required

Review the Quality Summary

Possible call
assessments

Chapter 6 Review the results n

Review the Quality Summary

The Quality Summary displays a list of the AccuSEQ® Software call assessments. This
summary includes the call assessment frequency and location for the open experiment.

For Mycoplasma SEQ experiments, the call assessments listed below may be triggered

by the experiment data.

Call Assessment

Description

All negative controls
failed

All negative controls yield fail result.

All positive controls
failed

All positive controls yield fail result.

Bad passive reference
signal

Passive reference signal is abnormal.

Baseline algorithm failed

The software cannot calculate the best fit baseline for the data.

Ct algorithm failed

The software cannot calculate Cy.

Exponential algorithm
failed

The software cannot identify the exponential region of the
amplification plot.

Failed IC prevents call

Values for Cy, DV, and T, met requirements for negative call but
detection of inhibition in IC prevents definitive absent call.

High background signal

The background fluorescence signal is higher than 1,300,000
fluorescent standard units (FSU).

Inhibition detected

Delta Cy and T, did not meet specified values required for
“Pass.”

NC criteria failed

Cr, DV, or T, did not meet specified values required for negative
control to“Pass.”

No signal in well

The well produced very low or no fluorescence.

Not supported by IC

Cr, DV, and T, results support absent call, but inhibition control
was not run. Absent call should be supported by additional data
demonstrating a lack of matrix inhibition.

PC criteria failed

Ct, DV, or T, did not meet specified values required for “Pass.”

Positive control signal
detected

Peak for discriminatory positive found in sample labeled as an
unknown indicating potential error in sample preparation or
plate setup.

Review Ct and DV values

Significant peak found within specified temperature range and
within specified Cy threshold, but DV magnitude insufficient for
positive call.

and/or

Ctand T, results support absent call but DV magnitude too high
for absent call.

Thresholding algorithm
failed

Data did not fit thresholding model.
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n Review the results Regulatory/restriction statement, if required
Review the Quality Summary

IMPORTANT! The parameters for a SEQ presence/absence experiment are customized
for detection of specific organisms and species and may yield different results than a
custom presence/absence experiment.

About the example  In the Mycoplasma Presence Absence Detection by MycoSEQ Example experiment, you

experiment review the Quality Summary for any call assessments generated by the experiment
data. In the example experiment, call assessments are generated for multiple wells,
including A1, A2, A4, and A5.

View the Quality 1. Click B8 Results in the navigation pane, then click Quality Summary.
Summary 2. In the Quality Summary table, look in the Frequency and Wells columns to

determine which call assessments appear in the experiment.

3. Click a call assessment in the table to display more information about the
assessment. The call assessment for multiple wells in the example experiment is
shown below.

Quality Summary

Call Aszessment Freguency Wells

All negative contrals failed
All pasitive controls failed
Bad passive reference signal
Baseline algarithm failed

C1 algarithm failed
Exponential algorithm failed
3 railed |C prevents call

Failed IC prevents call

High hackground signal

MG

HEEFEEEEEEEEEEE
m

Inhihition detected B& |
M criteria failed Hiz
Mo signal inwell
Mot suppoarted by 1C A3
e " -

Call Assessment Failed IC prevents call

Description CT, Dv and Tm results support absent call but inhibition control
demonstrates sample inhibition and prevents definitive call.

Wells A5
4 wiew Troubleshooting Inforrmation
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Regulatory/restriction statement, if required Chapter 6 Review the results n
Review the Amplification Plot

4. Click a troubleshooting link below the table to view information on correcting the
call assessment. An example of troubleshooting information is shown below.

A AccuSEQ™ Saftware v32.0

Review Call Assessments

e Related topics

(el Description Possible Cause Recommended Action
Assessment
Al positive Al positive controls Mo positive control Repeat the
controls yield Unexpected was added to the axperiment,
failed result, positive control well,

All negative All negative controls | Sample carryover,

controls yield Unexpected

failed result. Reagent
contamination.

5. To investigate the data for results, review plots (see page 61).

Guidelines for your =~ When you review your own Mycoplasma SEQ experiment:

experiment * Click each call assessment in the Flag Details table with a frequency > 0 to display
detailed information about the call assessment.

¢ Ifneeded, click the troubleshooting link to view information on correcting the call

assessment.
For more For more information on the Quality Summary screen or on call assessments, access
information the AccuSEQ® v2.0 Software Help by clicking @ or pressing F1.

Review the Amplification Plot

The amplification plot displays amplification of all samples in the selected wells. There
are three amplification plot views available:

* ARn vs Cycle — ARn is Rn minus the baseline; ARn is the magnitude of the
normalized fluorescence signal generated by the reporter at each cycle during the
PCR amplification. This plot displays ARn as a function of cycle number. You can
use this plot to identify and examine irregular amplification and to view
threshold and baseline values for the run.

* Rnvs Cycle — Rn is the fluorescence of the reporter dye divided by the
fluorescence of a passive reference dye; that is, Rn is the reporter signal
normalized to the fluorescence signal of the passive reference.

¢ Crvs Well - Cyis the PCR cycle number at which the fluorescence signal equals
the threshold in the amplification plot. This plot displays Cr as a function of well
position. You can use this plot to locate outlying amplification (outliers).
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Review the results Regulatory/restriction statement, if required
Review the Amplification Plot

About the example  You can examine the amplification plot to help with troubleshooting and quality
experiment control. In the Mycoplasma Presence Absence Detection by MycoSEQ Example experiment,
you review the amplification plot for:

e (Cypvalues
* Irregular amplification

e OQutliers

View the 1. From the navigation pane, select Plot Analysis » Amplification Plot.

Amplification Plots 2. Display all 96 wells in the amplification plot by clicking the upper left corner of

the plate layout in the Plate Layout tab.

3. (Optional) For an expanded display of the Amplification Plot, click in the upper
left corner of the plate layout in the Plate Layout tab.

£ | Plate Layou’rT Table View ]

3
> Select |- Selectit.. ~ | |- Selectit. ~ | |- Selectit. -
[0 | show inwells ¥ view Legend
2 1 2 3 4 5 B T

Sample 1 Sample 2 Sample 4 Sample G Sample 7

Sample 3 ISamleﬁ
|8 e e n e e
% 0, 40

Cm38... CTa3r... CT:26...0 Cm24...

Sample 1 Sample 2 Sam_ple4 Sample 5 Sample & Sample 7
.| @ @ O o O 0
CT:25.. CT:25.., Cr: 25 Cr:24... 0 Cm:24d..

4. Select the Plot Settings tab, and adjust the plot display, as shown on page 63:
a. From the Plot Type drop-down list, select ARn vs Cycle.
b. From the Graph Type drop-down list, select Log.
c. From the Plot Color drop-down list, select Well.
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Review the Amplification Plot

d. (Optional) Deselect the Save current plot settings as the default for this
experiment checkbox.

Amplification Plot

£ p By &2
Amplification Plot (ARn vs Cycle)
0w
1
0.1
0.01
=4
i
<
0.001
0.0001
0.00001
0.000001 — . T + r + T . : : : r : : : : : . : |
@ 4 & &8 0 12 W 1 @ »™ ® M X WM W B MW B H & 5
Cycle
Flot Seﬂingsl Options I Flot Legend ] 6
Plat Tyne: |ARnvs Cycle v | GraphType:|Log  ~ | PlatColor well -
Save current ot settings as the default fo| this experiment
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Review the results

Regulatory/restriction statement, if required
Review the Amplification Plot

9. Select the Options tab, then select to show the Threshold (0.2).

Flot Settings TOptions T Flot Legend ]

Target: Mycoplasma Assayw2.0 -
[Show: [/] Threshold — (7] Baseline Start: VWell B Target 4« Baseline End: Well (M Target 4.

Save current plot setlings as the default for this experiment

6. (Optional) Select the Plot Legend tab to view the well colors assigned to each row
in the plate layout.

J Plot Settings I Options TPIot Legend}

Lo

LB 2] ¢ D ME HFr Hc HH

7. Select wells in the plate layout to view in the amplification plot (see page 89 for
tips). For the example experiment, display the following replicate wells: A1, B1
(Sample 1), A6, B6 (Sample 6), H1, H2 (POS) and H11, H12 (NEG).

Amplification Plot (ARn vs Cycle)

0.2

01

0.01

ARR
s

m \ |
. I|I I \‘.‘ '-I W\ 1 /\ /
0001 =N O | \
VALY / /
\ B A [

0.0001 i
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While not present in this view, an inhibition control (IC) well can display a delay
in amplification (Ct value) as compared to the positive control (POS) well(s),
indicating that inhibitors are present in the unknown sample.
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Regulatory/restriction statement, if required

Chapter 6 Review the results
Review the Amplification Plot

8. (Optional) To view an area of the amplification plot in detail, click:

a. A quadrant in the plot to the left of the area you want to review.
b. (Zoom in).

Amplification Plot (ARn vs Cycle)
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9. (Optional) Click £

§= (Hide the plot legend).

Note: This is a toggle button. When the legend is hidden, the button changes to
Show a legend for the plot.
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Review the results Regulatory/restriction statement, if required
Review the Amplification Plot

Guidelines for your When you review the amplification plot for your own Mycoplasma SEQ experiment,
experiment look for:
e Qutliers

¢ A typical amplification plot with four distinct sections:
. Plateau phase

a
b. Linear phase

n

Exponential (geometric phase)

Q.

. Baseline

Amplification Plot (ARn vs Cycle)
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e (Correct baseline and threshold values

If your experiment does not meet the guidelines above, you can:

* Adjust the baseline and/or threshold (see page 80).
or

*  Omit wells (see page 84).

For more For more information on the Amplification Plot screen, access the AccuSEQ® v2.0
information Software Help by clicking @ or pressing F1.
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Regulatory/restriction statement, if required Chapter 6 Review the results n
Review the Melt Curve

Review the Melt Curve

About the The Melt Curve plot displays the fluorescence peak data collected at each well position
Melt Curve during the melt curve stage of an instrument run. For Mycoplasma SEQ experiments,
the AccuSEQ® Software determines the melting temperature (T,,) and reporter
signal (DV) for each peak.

Peaks in the melt curve can indicate the T, of the target (Target T,)) or can identify
non-specific PCR amplification (No Target T,,), where:

* The Target T}, is the temperature at which 50% of the DNA is double-stranded
and 50% of the DNA is dissociated into single-stranded DNA.

® The No Target T}, is a T, in the no-target range.

You can view the melt curve as normalized reporter (Rn) vs. temperature, or as
derivative reporter (-Rn') vs. temperature.

About the exampl_e In the Mycoplasma Presence Absence Detection by MycoSEQ Example experiment:
experiment e For the 7 Unknown wells:
— The mycoplasma target is present in Sample 6.

— The mycoplasma target is absent in Samples 1 and 3 (although Sample 3
lacks an IC).

— The Positive Control cross-contaminated Samples 4 and 7, leading to failed
calls.

— The AccuSEQ® Software v2.0 is unable to determine a result for Sample 2.

* One POS well failed because no peak in the POS control target range was
detected.

¢ One NEG failed due to cross-contamination with the POS control DNA.

View the Melt Click a sample in the plate layout or the well table to display the corresponding plots.

Curve 1. From the navigation pane, select Plot Analysis » Melt Curve.

2. (Optional) For an expanded display of the 96 wells of the Melt Curve, click » in
the upper left corner of the plate layout in the Plate Layout tab.

£| Plate Layout | Table View

>

| ElShowinWellsv | ViewLegend

3. In the Plot Settings tab, select:
a. Plot Type — Derivative Reporter
b. Target — Mycoplasma Assay
c. Color— Well

4. (Optional) Deselect the Save current plot settings as the default for this
experiment checkbox.
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n Review the results Regulatory/restriction statement, if required
Review the Melt Curve

5. (Optional) Select the Plot Legend tab to view the well colors assigned to each row
in the plate layout.

8 =
Melt Curve (Derivative Reporter)

Derivative Reporter (-Rn )

88.0
Tm: 84.64
Temperature (*C)

Plot Settings | Plot Legend | 5

Flot Type: Derivative Reporter  «  Targel hycoplasma.. - Colar Well -

Save current plot setlings as the default for this|experiment
i
4 3a 3b 3c

6. (Optional) Click §= (Hide the plot legend).

Note: This is a toggle button. When the legend is hidden, the button changes to
Show a legend for the plot.

7. Select wells in the plate layout to view in the melt curve plot:
a. In the first Select Item drop-down list, select Sample Type.
b. In the second Select Item drop-down list, select =.
c. In the third Select Item drop-down list, select:

* Unknown to view only UNKNOWN wells. The example experiment
contains review results for all UNKNOWN wells.

¢ Positive Control to view only POS wells. The example experiment
contains fail results for all POS replicate wells.
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Regulatory/restriction statement, if required Chapter 6 Review the results

Review the Melt Curve

¢ Negative Control to view only NEG wells. The example experiment
contains pass results for both IC well.

* Inhibition Control to view only IC wells. The example experiment
contains fail results for all of the IC wells.

7a 7b 7c
Plate Layout T Table View ]
Select: [Sample.. ~| = -] Unknu:lwn =] Display: Al ﬂ
Showr in Wells ¥ ewi Legend

The melt curve plot for the UNKNOWN wells in the example experiment is
shown below.

B & =
Melt Curve (Derivative Reporter)

Derivative Reporter (-Rn

Tempersture (°C)

Plot Settings | Plot Legend |

Plot Type: Derivative Reporter

~ | Target Mycoplasma... « | Color Well -

Save current plot settings as the default for this experiment
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Review the results
Review the table data

Guidelines for your
experiment

For more
information

Regulatory/restriction statement, if required

The T, value displayed below the melt curve plot is the T, associated with the largest
peak in the data, which may or may not be the Target T,,. You can determine the Target
T, by viewing the table data (see page 70).

Note: The T, value displayed below the plot may not exactly match the values
displayed in the well table because of rounding.

When you review your own Mycoplasma SEQ experiment, review the Melt Curve plot
for:

* The Target T, — The T,, is in the expected range.
¢ Unknown Calls:

~- @ Present

- (@ Absent

— (% Review

- € Fail
* Control Well Calls:

- @) DPass

- € Fail

For more information on the Melt Curve screen, access the AccuSEQ® v2.0 Software
Help by clicking @ or pressing F1.

Review the table data

About the example
experiment

View the Table View

70

The Table View displays results data for each well in the reaction plate, including the:
¢ Well number, sample name, sample type, assay, call, and call assessment

¢ Calculated values: Cr, target T;,,, DV, and ARn

Note: The ARn value is only available for display in the Table View when it is accessed
from the Plot Analysis screens.

For the Mycoplasma Presence Absence Detection by MycoSEQ Example experiment, group
the wells in the Table View by:

e Call

e (Call assessment

-_

From the navigation pane, select Plot Analysis, then select the Table View tab.

2. (Optional) For an expanded display of the Table View, click € in the upper left
corner of the table in the Table View tab.

3. Use the Group By drop-down list to group wells by a specific category.

Note: You can select only one category at a time.

For the example experiment:
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Regulatory/restriction statement, if required Chapter 6 Review the results n
Review the table data

a. From the Group By drop-down list, select Call. Wells are listed in the order:

e Fail
e Pass
e Review

e Empty Well (no call)

Plate Layout | Table View ]

Select  Sample .. j = j Unknown j Display. Al j
| Show in Table ¥ | Group By ¥ | | @ Expand All | @ Collapse All |
Well Position (Rowd
# WellPo.. Sa W'ell Position (Calumn) Call Call Agse.. TargetTm DV ARN Cycle 1 Fl...
3a 2 apzert v Cal -
1 Al Sal Bssay B Absent 0.43570167 288097 5625
2 A3 Sa Absent Mot support... 0.03529561 271497 .84..
T Sample Marne
3 At Sa Sample Type 3 Fail Positiveco.. S4.644607.. 2.8577594 6.470302 26330496
4 AT Sal Mone 5 Fail Positive co..  79.949326. 3.2145602 73199463 25860820
5 B5 Sampl... Inhibition Cont... Fail Inhibiion ... 84.476921.. 0.3224787.. -0.13247736906129.1875
B HZ POS1 Positive Control 37570594 Fail PC criteriaf. 1.0556548 300595.09..
7 H12 MEG 1 Negative Gont. 26.811232 Fail NG criteriaf.. 79110763, 0.8690499 B.6311073 303521 .21
= Pass E
8 Bt Sampl... Inhibition Cont... 25.259483Pass 84476921, 2.9316086.. B.8240485273631.6075
9 B2 Sampl... Inhibition Cont... 25.735079 Pass 24.644607... 2.9011220.. B.3282127 22018796,
10 B4 Sampl... Inhibition Cont... 25.23157 Pass 84644607, 209275162.. B.7246466277926.0375
11 Ef  Sampl... Inhibition Cont 24 GEG37 Pass 84.812301... 2.8713450 73022447 26771204
12 B7 Sampl... Inhibition Cont 24 627481 Pass 84812301, 29288535 732015 257106.73
13 H1 POS1  Positive Control 25.747845Pass 84.644607... 2.9083828.. B.633214 285969.6875
14 H11 MEG1 HNegative Cont. 39.820956 Pass 0.21818866 212092.6875
= Present
15 Af Sampl.. Unknown 26.17924 Prasent B0.284614. 33082644 75321107 263318.03
= Review
16 A2 Bampl.. Unknown 37.42647 Revigw Review CT... 75588225, 1.1842676.. 1.22200281 20427834
17 AG - Bampl.. Unknown Review Failed IC pr.. 84 4765321.. 0.2890349.. 0030283526 885916.3125
=l Empty Well
1" an

In the example experiment:
* Review — Unknown sample wells A2 and A5
e Fail - A4, B5, A7, H2 and H12

b. From the Group By drop-down list, select None. In the table, click the
column heading Call Assessment. Wells are sorted by the assigned call
assessment. Click the column heading again to reverse the sort order and
bring the wells with call assessments to the top of the table.

# WellPo.. Sam.. SampleType CT Call rgetTm D AR Cycle 1 FIL.
= Absent

1 Al Bampl... Unknown 38712776 Absent 0.43570167 288097 5625
2 A3 Bampl... Unknown Absent Mot support... 0.03529561 271497 .84,
= Fail
3 B5 Sampl... Inhihition Cont... Fail Inhibition d... 84476921, 0.3224787... -013247736906129.1875
4 H12 MEG1 MNegative Cont... 26.811232 Fail MG criteria f... 79.110763... 0.8690499.. 6.6311073 303521.21...
a H2 POS1  Positive Control 37870595 Fail P criteria 1. 1.0856548 300595.09...
B A4 Sampl... Unknown 27 477598 Fail Positive co.. 84.644607.. 28577594 . B.470302 269304 96..
7 A7 Sampl... Unknown 24 648975 Fail Positive co.. T9.949226.. 32145602, 7.3199463 258698.20...
=l Pass
8 E1  Sampl... Inhihition Cont... 25259483 Pass 84 476921, 29316086.. 6.8240485273631.6875
9 E2 Sampl.. Inhihition Cont... 25735079 Pass 94 644607, 29011220, 6.3282127 320187.96..
10 B4 Sampl... Inhihition Cont... 2523157 Pass 84 644607, 29275162, G6.7246466 2779259375
i E6 Sampl.. Inhihition Cont... 24 BBG3Y Pass 84812301, 28713450, 7.3022447 257712.04..
12 E¥ Sampl.. Inhibition Cont... 24 G27481 Pass 84.812301... 2.9288535.. T.320148 287106.73..
13 H1 POS1  Positive Caontrol 25 T47845Pass 84 644607, 2.9083828.. B.633214 285969 6875
14 H11 MEG1 MNegative Cont... 39.829956 Pass 0.21818866 312992.6875
= Present
15 AB Bampl... Unknown 26.17924 Present 800284614, 3.3082644.. T.5321107 263318.03..
= Rewview
16 A5 Bampl... Unknown Review Failed I pr.. 84476921, 0.2890349..0.0302835268855916.3125
17 A2 Sampl... Unknown 37 42647 Review Review CT.. T5A89225.. 1.1842676... 1.2289081 304278.34..
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Review the results
Export and print the data

Guidelines for your
experiment

For more
information

Regulatory/restriction statement, if required

In the example experiment:
¢ Inhibition detected — Unknown sample B5
¢ Failed IC prevents call - Unknown sample A5

When you review your own Mycoplasma SEQ experiment using the Table View:

* Group the wells by:

— Call - The software groups the called and uncalled wells. For a description of
the Mycoplasma presence/absence calls, see page 53.

— Call Assessment — The software groups the wells by call assessment. For a
description of the possible Mycoplasma call assessments, see page 59.

e Review the following values for wells with review or fail results:
— Target T\, and DV
- Cr

* (Optional) To further investigate questionable results, see Chapter 7.

For more information on the Table View, access the AccuSEQ® v2.0 Software Help by
clicking @ or pressing F1.

Export and print the data

For more
information

72

You can publish the experiment data in several ways:
¢ Export data
* Save a plot as an image file
¢ Printa plot
¢ Print the plate layout
* Create slides

¢ Print a report

For information on performing these procedures, access the AccuSEQ® v2.0 Software
Help by clicking @ or pressing F1.
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(Optional) Investigate the results

Chapter OVerview . . ...
About the analysisresults.......... .. ... oo i i
Review the Multicomponent Plot .............. ... ... ... ...
Review the Raw Data Plot. . ...... ... ... ... .. .. ..

Review the analysis settings................... ... ... ... ...

Omit wells from the analysis ............ ... i

Chapter overview

Example
experiment
workflow

After you review any questionable results in the Quality Summary, Amplification plot,
and Melt Curve plot as explained in Chapter 6, you can investigate any questionable
results that require further examination using the remaining plot analysis screens. This

chapter explains how to further investigate the analysis results of the example
experiment using the Multicomponent and Raw Data plots, and how to review the
analysis settings and omit wells from the analysis.

See “Navigation tips” on page 89 for information on navigating within the analysis
results screens.

The workflow for investigating the analysis results for the example experiment data

provided with this getting started guide is shown on page 74.
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7 (Optional) Investigate the results
About the analysis results

Start experiment
v
Set up the experiment (Chapter 2)
v
Prepare the reactions (Chapter 3)
v
Run the experiment (Chapter 4)
v
Review the Results Summary (Chapter 5)
v
(Optional) Review the Results (Chapter 6)
v
(Optional) Investigate the Results (Chapter 7)
1. Review the Multicomponent Plot.
2. Review the Raw Data Plot.
3. Revew the Raw Data Plot.
4. Review the analysis settings.
5. Omit wells from the analysis.
v

End experiment

About the analysis results

About the results If you cannot determine the source of results identified as questionable in the Quality
Summary, use the Multicomponent and Raw Data plots to review the amplification
data for the plate, then edit the analysis (Cr) settings and omit wells from the analysis
as needed.

About the example  To investigate the Mycoplasma Presence Absence Detection by MycoSEQ Example
experiment experiment results, open the data file that installs with the AccuSEQ® Software
(see page 17). For the example experiment, investigate wells: A2, A4, A5, A7, B5, H2
and H12.

Guidelines for your  To investigate the example experiment and your own Mycoplasma SEQ experiment:
experiment * Open a Mycoplasma SEQ experiment that contains run data.

* Review the run results in the Results Summary (see Chapter 5).
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Chapter 7 (Optional] Investigate the results

Review the Multicomponent Plot

If needed, review any questionable results in the Quality Summary (see page 59),
then review plots as needed (see page 61).

As needed, investigate questionable results:
— Review the Multicomponent and Raw Data plots (see page 75).
— Review the analysis (Cr) settings (see page 80).
— Omit wells from the analysis (see page 84).

Review the Multicomponent Plot

The Multicomponent Plot screen displays the complete spectral contribution of each
dye in a selected well over the duration of a PCR run.

About the example  In the Mycoplasma Presence Absence Detection by MycoSEQ Example experiment, you
experiment review the Multicomponent Plot for:

View the 1.
Multicomponent 2
Plot
3.
4,
5.

AccuSEQ® Software v2.0 Mycoplasma SEQ Experiments Getting Started Guide

SYBR® Green dye
ROX™ dye
Spikes, dips, and/or sudden changes.

Amplification in the negative control wells.

From the navigation pane, select Plot Analysis » |[Z# | Multicomponent Plot.

. Select the Plot Settings tab, and adjust the plot display:

a. From the Plot Color drop-down list, select Dye.
b. (Optional) Deselect the Save current plot settings as the default for this
experiment checkbox.

(Optional) Select the Plot Legend tab to view the color assigned to each dye in the
experiment.

Plot Settings | Piot Legend | L3

Plat Colar [Dye v

I;l Save current plct settings as the default for this experiment

|
2b 2a
(Optional) Click §= (Hide the plot legend).

Note: This is a toggle button. When the legend is hidden, the button changes to
Show a legend for the plot.

Display the wells one at a time in the Multicomponent Plot screen:

a. Click the Plate Layout tab.
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7 (Optional) Investigate the results
Review the Multicomponent Plot

6.

b. Select one well in the plate layout; the well is shown in the Multicomponent
Plot screen. The plot for well A6 (= review UNKNOWN) in the example
experiment is shown below.

(T
M
B g 2=
Multicom ponent Plot
2,500,000
2,700,000
2,600,000
2,500,000
2,400,000
2,300,000
2,200,000
2,100,000
2,000,000
1,800,000
1,800,000
1,700,000
o 1,600,000
<}
< 1,500,000
ﬁ 1,400,000
S 1,300,000
i
1,200,000
1,100,000
1,000,000
900,000
800,000
700,000
600,000
500,000
400,000
300,000
200,000
100,000
0
0 2 a @ o 101 i} 0
Cycle
Plot Settings | Plof Legend
Plot Color |Dye =
Save current plot settings as the default for this experiment

(Optional) For an expanded display of the Amplification Plot, click » in the upper
left corner of the plate layout in the Plate Layout tab.

Check the ROX dye signal. In the example experiment, the ROX dye signal
remains constant throughout the run.

Check the SYBR dye signal. In the example experiment, the SYBR dye signal

should not significantly increase for NEG wells, if the call for an UNKNOWN
well is Absent, or if the call for a POS well is Fail. The SYBR dye signal should
increase for POS and IC wells, or if the call for an UNKNOWN well is Present.

Guidelines for your ~ When you review your own Mycoplasma SEQ experiment, look for:

experiment * Passive reference (ROX dye)- The passive reference dye fluorescence level

76

should remain relatively constant throughout the PCR process.

Reporter (SYBR dye) — The reporter dye fluorescence level should display a flat
region corresponding to the baseline. If target is present in the sample (a Present
call is made), the baseline will be followed by a rapid rise in fluorescence as the
amplification proceeds.
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For more
information

Chapter 7 (Optional] Investigate the results
Review the Raw Data Plot

* Irregularities in the signal — There should not be any spikes, dips, and/or sudden

changes in the fluorescence.

* Negative control wells — There should be no significant amplification in the
Negative Control wells. Non-specific amplification may occur and result in a Cy
value, but T,,, will not be within target range.

For more information on the Multicomponent Plot screen, access the AccuSEQ® v2.0
Software Help by clicking & or pressing F1.

Review the Raw Data Plot

About the example
experiment

View the Raw Data
Plot

The Raw Data Plot screen displays the raw fluorescence (not normalized) for each
optical filter for the selected wells during each cycle of the real-time PCR.

In the Mycoplasma Presence Absence Detection by MycoSEQ Example experiment, you
review the Raw Data Plot screen for a stable increase in signal (no abrupt changes or

dips) from the appropriate filter.

1. From the navigation pane, select Analysis » % Raw Data Plot.

2. (Optional) Select the Plot Legend tab to view the well colors assigned to each row

in the plate layout.

3. Display all 96 wells in the Raw Data Plot screen by clicking the upper left corner
of the plate layout in the Plate Layout tab.

f Plate Layout I Table View ]

Select: |- Selectit.. v | |- Selectit. = | [ Selectit. ~|

[0 showin wells ¥

Wiew Legend

33— [ 1t [ 2z |

3 | ¢ s [ B8 7 |

Sample 1 Sample 2

=

|

Crm328.. Cm37..

Sample 1 Sample 2

| @ ©@

[1C SERTC

Cr25.. Cm25..

‘! Sag 3 @
m @

Sample 4 Sample & Sample 7

Sample S
o O m
Cr:27... Cr:26...; C7:24...

Sam_ple4 Sample 5 Sam_pleﬁ Sample 7
@

Cr:25.... Cr:24..; Crm: 24,

AccuSEQ® Software v2.0 Mycoplasma SEQ Experiments Getting Started Guide 77



7 (Optional) Investigate the results
Review the Raw Data Plot

4. In the Plate Layout tab, select wells corresponding to sample replicates. For the
example experiment:

¢ Unknown sample wells (including Inhibition Control wells) — In the Select
section, select Sample Name in the first drop-down list. In the second drop-

down list,. select =. In the data entry field, enter a sample name, for example,
POS 1. Then click to display results:

Plate Layout T Table View }
4 Select [Sample .. ~|[= =] Posi D\sp\av: Al =1
| [0 ] show in wells w | ) view Legend ‘ |
12 [ 3 [ 4 [ s [ 8 [ 7 [ & [ 8 [ 10 [ 1 |12

Sample 1 Sample 2 — Sample 4 - Sample & Sample 7

’ ) @ O ¢
m m O
CT: 38 CT: 37 CT 27 CT: 26 CT 24
Sample 1 Sam_p\e 2 Sam_ple4 Sample 5 Sam_p\e & Sample 7

g @
Cm25.. Cma2s.. CT25.... Cr:24.. Cm24..

c

D

E

F

5
FPOS 1 FOS1 NEG 1 NE®G 1

’ 0 0
CT25.. CmaT.. (o ic=B Cr26..

Use filters to specify wells for selection. Your specification can be whole (for
example, Sample Name=Sample 7) or partial (for example, Sample Name
contains 7). You can narrow your specification to selected or unselected
wells.

5. Click and drag the Show Cycle pointer from cycle 1 to cycle 138, and review the
data from each filter:

* The data from filter 1 correspond to the signal from SYBR® Green dye, the

reporter for the Mycoplasma target. Increase indicates amplification of the
target.

 The data from filter 4 correspond to the signal from ROX™ dye, which is
used as the passive reference.
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Guidelines for your

experiment

For more
information

The filters are:

Chapter 7 (Optional] Investigate the results
Review the Raw Data Plot

Filter 1 2 3 4 5
Dyels) | FAM™ dye JOE™dye | TAMRA™ dye | ROX™ dye | Cy®5 dye
SYBR® Green | VIC® dye | NED™ dye Texas Red®
dye Cy®3 dye dye

The filter data from cycle 37 for Sample 6 in the example experiment is shown

below.

Raw Data Plot

2,900,000
2,800,000
2,700,000
2,600,000
2,500,000
2,400,000
2,300,000 |
2,200,000

1,800,000
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1,700,000
1,600,000
1,500,000
1,400,000
1,300,000
1,200,000
1,100,000
1,000,000
900,000
800,000
700,000
600,000
500,000
400,000
300,000
200,000
100,000

0
100,000

Amplituds

1

\
2100000 | Y
2000000

Options | Plot Legend

Raw Data Plot

a iy & =

Show Cycle 37

Y

lq 50

6. Repeat step 4 and step 5 for each sample replicate.

7. (Optional) Click = (Hide the plot legend).

Note: This is a toggle button. When the legend is hidden, the button changes to
Show a legend for the plot.

When you review the Mycoplasma SEQ experiment, look for the following in each filter:

¢ Characteristic signal growth

* No abrupt changes or dips

For more information on the Raw Data Plot screen, access the AccuSEQ® v2.0 Software
Help by clicking & or pressing F1.
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(Optional) Investigate the results

Review the analysis settings

Review the analysis settings

About the example
experiment

View the analysis
settings

Ct Settings

80

Note: You must have administrator or scientist privileges to access the
Analysis-Analysis Settings menu.

You can review and edit analysis settings for the threshold cycle (Crt) for Mycoplasma
SEQ experiments, Mycoplasma Presence Absence calls, and quality check (QC) and
peak noise.

In the Mycoplasma Presence Absence Detection by MycoSEQ Example experiment, the
pre-defined analysis settings are used without changes.

Select Analysis » Analysis Settings to open the Analysis Settings dialog box.

For the example experiment, the pre-defined analysis settings are displayed in the
Cr Settings tab:

| as

)Analys\s Settings for Mycoplasma SEQ Example @

J Ct Settings T Call Settings I QC and Moise Settings ]

Review the default settings for analysis oftargets in this experiment. To edit the default settings, click "Edit Default Settings " To use
different seftings for a target, select the target from the table, deselect"Use Default Settings " then change the settings that are displayed

Default C1 Settings
efault CT settings are used to calculate the CT for targets without custorn seftings. To editthe default seftings, click "Edit Default Settings."

Threshald: 0.2 Baseline Start Cycle: 3 Baseline End Cycle: 15 \ Eclit Defautt Settings: \

Select a Target Cr Settings for Mycoplasma Assay v2.0
arget Thrashald Baseline Start Baseline End CT Settings to Use: [7] Use Default Settings
coplasma Assa.. (0.2 3 15 i [T] Automatic Threshald

Threshold: |0.2

m

[] Automatic Baseline

Baseline Start Cycle: | 315 End Cycle: | 15615

f [T 3

Revert to Detault Analysis Settings Apply Analysis Settings Cancal

The Cy Settings tab shows the pre-defined Cr analysis settings for Mycoplasma SEQ
experiments, optimized in the AccuSEQ® Software for use with the PrepSEQ® Sample
Preparation Kits.

Note: For details on the Mycoplasma assay and detection kit, refer to the MycoSEQ
Mycoplasma Detection Kits User Guide.

Select Analysis » Analysis Settings to open the Analysis Settings dialog box.

For the example experiment, the pre-defined analysis settings are displayed in the
Cr Settings tab:
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Chapter 7 (Optional] Investigate the results

Review the analysis settings

| Las

3Analys\s Settings for Mycoplasma SEQ Example @

J Cr Settings T Call Settings T QC and Moise Settings ]

Review the default settings for analysis of targets in this experiment. To edit the default settings, click "Edit Default Settings " To use
different seftings for a target, select the target from the table, deselect "Use Default Settings " then change the settings that are displayed.

Default C1 Settings
efault CT settings are used to calculate the CT for targets without custorn settings. To editthe default seftings, click "Edit Default Settings "

Threshold: 0.2 Baseline Start Cycle: 3 Baseline End Cycle: 15 \ Eciit Defautt Settings \

Select a Target Cr Settings for Mycoplasma Assay v2.0

mroet Threshaold Baseline Start Baseline End CT Gettings to Use: [7] Use Default Settings

o
toplasma Assa...|0.2 3 15 [] Automatic Threshold

Threshold: |0.2

m

[] Automatic Baseline
Baseline Start Cycle: | 312 End Cycle: | 1515

f [T 3

Bevert to Default Analysis Settings Apply Analysis Settings Cancel

Call Settings To review Mycoplasma and Presence Absence call settings for unknown samples,

positive control and inhibition control, and negative control, click the Call Settings
tab.

Edit the settings for thresholds and ranges by clicking and dragging a “thumb control”
left or right. As you drag a thumb control, the settings in the table change.

Set Cy limits for calls

You can change the Cr limits for the following calls:
* Unknowns: Ct for Unknown samples

¢ Positive Control and Inhibition Control: DV Threshold for Postive Control and
Delta Cr for Inhibition Control

* Negative Control: Ct for Negative Control and DV Threshold for Negative
Control

To change threshold settings, click anywhere in a threshold, then drag the [ | thumb
control. For finer granularity, use keyboard arrows to move the thumb control.

Range settings

You can change the settings for the upper and lower boundaries of ranges on the
following calls:

¢ Unknowns: DV Range for Unknown samples and T,, Range for Unknown
samples

* Positive Control and Inhibition Control: Cy Range for Postive Control and T,
Range for Positive Control and Inhibition Control

* Negative Control: T;, Range for Negative Control

AccuSEQ® Software v2.0 Mycoplasma SEQ Experiments Getting Started Guide 81



(Optional) Investigate the results
Review the analysis settings

To change the setting for only the upper boundary range, drag the bottom, down arrow

on the 3 thumb control.

To change the setting for the lower boundary range, drag the # thumb control.

To simultaneously change the upper and lower boundaries, place your cursor on the
J control. When the cursor changes to &, drag the control.

F Analysis Settings for Mycoplasma SEQ Example

Ct Settings | Call Settings T QC and Noise Settings ]

L]

‘ Unknowns ‘ ‘ Positive Control and Inhikition Cortral | | Megative Control |

Review and editthe Mycoplasma Presence Absence call seftings for Positive Cordrol and Inhibition Control

CT Range for Positive Control | BENE | | To Change only the upper
Thumb 200 250 ao | boundary, drag the down
controls 0 arrow on this thumb control
D% Threshald for Pasitive Cantral
05 1.0 1.4 20 24
d
Tm Range for Pasitive Cantral and Inhibition Cordral . 2 | . R
ao0.o arao
Delta CT for Inhibition Control lj
0o 04 1.0 1.4 20 25 30
Arrow keys can be used to move the slider for finer granularity,
For Positive Control
Call cT [ Tm Inhibition
Pass 235=K==175 =20 092.0 ==X ==186.0 Pass or Fail or Mot Used
Fail Any other than Pass Any other than Pass \Ary other than Pass \Ary other than Pass

QC and Noise

Settings
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For Inhibition Control

Call Delta CT ™™
Pass <20

83.0 ==} == 86.0

Fail lAny other than Pass

Any other than Pass

| Eevert to Default Analysis Seftings

Apply Anatysis Settings |

Cancel

In Mycoplasma SEQ experiments, you can edit QC and noise settings, which control

enabling or disabling quality check flags, and editing the high background threshold
and the derivative value (DV) for the peak noise threshold.

To edit QC and noise settings:

1. Click Analysis in the top menu, then Analysis Settings.

Click the QC and Noise Settings tab.

To change the default Enable setting for quality check flags, click Disable.

2
3
4. To edit the high background threshold, enter a value in the data entry field.
5

To edit the peak noise threshold, enter a value in the data entry field.
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Review the analysis settings

3 Analysis Settings for Mycoplasma SEQ Example ===

[ CT Settings ] Call Settings | QC and Noise Settings |

Quality Check Flags

@ Enable

Disable

Disabling quality check flags disables the following ags
= Higgh background signal
* Baseline algorithm failed
= Auto-threshold failed
= Bad passive reference signal
= Exponential algarithm failed
= Mo signal inwell

= T algorithm failed

High Background

Assay will fail if background value exceeds this threshold.

High background threshald 1300000

Peak Noise (DV)

Peaks that exceed threshald will be anahzed
Peaks below the threshald will be considered noise and not analyzed.

Peaknoise threshold  0.06

Revert to Defaul Analysis Settings

Restore default
analysis settings

Save edited
analysis settings

Apply Analysis Settings Cancel

To restore the default call settings, click Revert to Default Analysis Settings.

To use the edited call settings, click Apply Analysis Settings. If the run status for the
experiment is complete, the data are reanalyzed.

Guidelines for your

IMPORTANT! Cr settings are optimized for each assay. If you change settings,
particularly autobaseline, assay results may be affected.

Note: You must have administrator or scientist privileges to access these functions.

When you reset the threshold and baseline, keep the following Applied Biosystems
recommendations in mind:

Recommendation

Enter a value for the threshold so that the threshold is:

¢ Above the background.

¢ Below the plateau and linear regions of the amplification curve.
¢ Within the exponential phase of the amplification curve.

Select Start Cycle and End Cycle values so that the baseline ends
before significant fluorescence is detected.

experiment
Setting
Threshold
Baseline
For more

information
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For more information on the analysis settings, access the AccuSEQ® v2.0 Software Help
by clicking & or pressing F1 when the Analysis Settings dialog box is open.
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Omit wells from the analysis

About the example
experiment

Omit wells

You may omit wells from analysis if you do not want to consider data generated by the
well.

In the Mycoplasma Presence Absence Detection by MycoSEQ Example experiment, there
are no outliers; no wells need to be removed from analysis.

To omit wells in your own Mycoplasma SEQ experiment:

1. Click Plot Analysis in the navigation pane. The software displays the
Amplification Plot screen by default.

2. Inthe Plate Layout tab, select one or more wells to omit from analysis (see page 89
for tips).

Note: Alternatively, you can omit wells from the Table View. See the AccuSEQ®
v2.0 Software Help for more information.

3. Right-click the well(s), then select Omit. For example:

Plate Layout | Table View |

84

Select: |- Selectlt. ~ | |- Selectit. - |

=]

Display: |All

| El Show inWells ¥

Yiew Legend

=

1

2

3 1|

]

s | 7 [ & [ 8 |

I

.| &

Cm25..

Sample 1 Sample 2

4

Cm38.. Cm237.. m

Sample 1 Sample 2

[/

Cr25....

s le 4
‘Sample 3 SRS

CrT:27....

Sample &

s

Sample & Sample 7

Cr:26... Cm:24.

ZoamIn
Zoormn Out
Fit Plate

Full Screen

Sample 7

V]

Cr24...

I Omit

Include
Sawve A
Print Preview

Print

Add/Edit Comment(s)

Results for the well are removed (indicated by [).

Click Analyze to re-analyze the data without the omitted wells.

Specify a reason for change, if prompted. For more information, see “Security,
Audit and E-Signature (SAE) for users” on page 87.
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Omit wells from the analysis

Guidelines for your ~ When you review your own Mycoplasma SEQ experiment, carefully consider which
experiment wells to omit from analysis. If needed, remove outliers manually using the Table View.

1. From the navigation pane, select Plot Analysis » Amplification Plot.

2. In the Amplification Plot screen, select Ct vs Well from the Plot Type drop-down
list.

3. Select the Table View tab, then review the table data:
a. Look for any outliers.

b. Select the Omit check box next to the outlying well(s).

4. Click Analyze to re-analyze the experiment data with the outlying well(s)
removed from the analysis.

5. Specify a reason for change, if prompted. For more information, see “Security,
Audit and E-Signature (SAE) for users” on page 87.

For more For more information on omitting wells from the analysis, access the AccuSEQ® v2.0
information Software Help by clicking & or pressing F1.
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SEQ template workflow. . ........ ... . 90

Security, Audit and E-Signature (SAE) for users

The AccuSEQ® v2.0 Software includes security, audit, and electronic signatures
features. Depending on the way that your administrator configures these features, you
may see the following dialog boxes and prompts when you use the software:

Feature Dialog Boxes and Prompts Description

Security B cuSEQ™ Software v2.0 Login == To access the software, you provide a user name
s and password. If your system is configured for
periodic password expiration, you will periodically

be prompted to change your password. If your
system is configured to monitor consecutive failed
log in attempts, you will be locked out of the
software if you incorrectly enter your user name
or password for a specified number of times.

Audit s &) | If your system is configured for auditing, you may
B Selectan auditreason, enter a comment (optional), then click "OK”. be prompted to Specify a reason when you make
pudtEvertSommary certain changes in the software.
Audit Event Old Value New Value

Experiment Properties Experiment Description Edited New Test Run Lastweek's Test Run

Additionally, you can generate and print an
experiment audit report that includes all audit
records for an experiment.

Reason:  |None

Comment |Changed the description since this test run jvas performed last wek
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Feature Dialog Boxes and Prompts Description
Electronic (5 to veriﬁcaﬂon‘ ™0 If your system is configured for electronic
Signature signature, you may be prompted to provide your
Select an action, enter a comment (optional), user name and password when you perform
;f/)_l @ enter your username and password, then certain actions in the software.
: click "E-Sig."

You can also sign an item on-demand (for

Experiment: Mycoplasma_23Feb2012 . . .
example, you can sign results after viewing them).

Action: |Review -

Note: The electronic signature function is
Meaning available only after an experiment contains data;

Review Edits the E-Sig button is dimmed for new experiments.

Comment If an item is set to require two signatures, the

a signers are not required to sign at the same time.
When the first signer signs, the E-Sig status is set
to Partially Signed. When the second signer signs,
the E-Sig status is set to Signed.

Additionally, you can generate and print an
electronic signature report that all electronic
signature records for an experiment.

Username: ||

Password:

| | | LCancel

For more information on the SAE features available in the AccuSEQ® Software, refer to
the AccuSEQ® v2.0 Software Help.
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Appendix A Reference Information A
Navigation tips

Use the following procedures to navigate within the Results and Plot Analysis screens.

How to select wells  To display specific wells in the analysis results screens, select the wells in the Plate
in the plate layout Layout tab as follows:

1.

To change the data displayed in the Plate Layout, click [@ Show in Wells, then
select (or deselect) the data to display in the plate layout.

To select wells of a specific type, use the Select drop-down lists. Select a well
position; omit a well; or select a sample name, sample type, assay, Cr, call, call
assessment, target T,,,, or DV. Use filters to specify your selection, for example,
Sample Name=Sample 12.

To select one well, click the well in the plate layout.

To select multiple wells, click and drag over the desired wells, or press Ctrl-click
or Shift-click in the plate layout.

To select all 96 wells, click the top-left corner of the plate layout.

2

Plate Layout | Table View
Selest [Sample... 7 |[= | sample 7| Dwsmav Al |
'1 ,Imshnwmwws v | [ view Legend
5 1 [ 2 | 3 | 4 5 6 7 8
a m Sample 1 E Sample 1 Fample 1 Sample 1
a m Sample 2 m Sample 2 Sampls 2 m Sample 10 Samgle 10
dp | & .= =
How to di splay Use the Multiple Plots view to display up to four plots simultaneously. To navigate
multiple plots within the Multiple Plots view:
1. From the navigation pane, select Plot Analysis » |£4] Multiple Plots View.
2. To display four plots, click 55 Show plots in a 2 X 2 matrix.
3. To display two plots in rows (default view), click = Show plots in two rows.
4. To display two plots in columns, click ||| Show plots in two columns.
5. To display a specific plot, select the plot from the drop-down list above each plot

display.
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Plot Settings | Plot Legerd |

FlotType: Derivative Reporter | Target Al ~ | Colar |Sample -

Save current plot seftings as the default for this experiment

SEQ template workflow

Create a template

90

You can use a SEQ template (*.edt file type) to create a new SEQ experiment (*.eds file
type). Templates allow you to create many experiments with the same setup

information.

1. Double-click .j (AccuSEQ Software).

2. Enter your user name and password, then click OK.
Note: See your system administrator for user name and password.

3. Open an existing SEQ experiment (see page 42), or create a new SEQ experiment
(see page 23).

4. Select File » Save As Template.

5. Enter a file name, select a location for the template, then click Save.

Click £ Close.
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Save a template as 1. In the Home screen, click Open Experiment.

an experiment From the Files of Type list, select Experiment Document Template files (*.edt).

Locate and select the template to use, then click Open.

M LD

(Optional) Modify the setup information from the template, as needed:
¢ Experiment properties
* Sample setup

¢ Plate layout
5. Select File » Save As to save the template as an experiment (*.eds file type).
6. Enter a file name, select a location to save the experiment. then click Save.

7. Specify a reason for change, if prompted. For more information, see “Security,
Audit and E-Signature (SAE) for users” on page 87.

8. Run the experiment, as needed.

Create an 1. Select File » New Experiment » From Template.

experiment with a 2. Locate and select the template to use (*.edt file type), then click Open. A new

template experiment (*.eds file type) is created using the setup information from the
template:

* Experiment properties
e Sample setup

¢ Plate layout
(Optional) Modify the setup information from the template, as needed.
Click [dl Save to save the experiment.

Enter a file name and select a location for the experiement, then click Save.

o o M~ w

Specify a reason for change, if prompted. For more information, see “Security,
Audit and E-Signature (SAE) for users” on page 87.

7. Run the experiment, as needed.
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absent result

amplification

amplification plot

amplification stage

assay

Audit

AutoDelta

Glossary

In Mycoplasma SEQ experiments, a sample result indicating that:

¢ Target signal is not present within the temperature range, derivative range, and
Cr range for the assay.

* Passive reference is found, noise is below threshold, controls have “pass” results.

The process of making copies of and thereby increasing the amount of a specific DNA
sequence.

Display of data collected during the cycling stage of PCR amplification. Can be viewed
as:

* Baseline-corrected normalized reporter (ARn) vs. cycle

¢ Normalized reporter (Rn) vs. cycle
* Threshold cycle (Ct) vs. well

Part of the instrument run in which PCR produces amplification of the target. The
amplification stage, called a cycling stage in the thermal profile, consists of denaturing,
primer annealing, and polymerization steps that are repeated.

For Mycoplasma SEQ experiments, fluorescence data collected during the amplification
stage are displayed in an amplification plot, and the data can be used for
troubleshooting.

In the AccuSEQ® Software, a predefined experiment designed to detect an organism or
group of organisms.

Administrator-configurable function that tracks the user, date, and time associated
with certain actions or changes made in the software. Can be set to prompt users to
enter reasons for change.

Audit reports can be viewed in the SAE Manager (administrators only) and the
Experiment window.

In a custom experiment run method, a setting to increase or decrease the temperature
and/or time for a step with each subsequent cycle in a cycling stage.

In SEQ experiments, AutoDelta is set to On and cannot be modified. In custom
experiments, AutoDelta can be turned On or Off.

When AutoDelta is enabled for a cycling stage, the settings are indicated by an icon in
the thermal profile:

e AutoDelta on: A

¢ AutoDelta off: &
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automatic baseline

automatic Cy

baseline

baseline-corrected
normalized reporter
(ARN)

Cr
chemistry

custom experiment
workflow

cycle threshold
cycling stage

data collection

delta Rn (ARN)

derivative reporter
(—-Rn’)

dissociation curve

94

An analysis setting in which the software calculates the baseline start and end values
for the amplification plot. You can apply the automatic baseline setting to specific wells
in the reaction plate. See also baseline.

An analysis setting in which the software calculates the baseline start and end values
and the threshold in the amplification plot. The software uses the baseline and
threshold to calculate the threshold cycle (Cy). See also threshold cycle (Cr).

In the amplification plot, a line fit to the fluorescence levels during the initial stages of
PCR, when there is little change in fluorescence signal.

The magnitude of normalized fluorescence generated by the reporter. In experiments
that contain data from real-time PCR, the magnitude of normalized fluorescence
generated by the reporter at each cycle during the PCR amplification. In the ARn vs.
Cycle amplification plot, ARn is calculated at each cycle as: ARn (cycle) = Rn (cycle) —
Rn (baseline), where Rn = normalized reporter.

See also normalized reporter (Rn).
See threshold cycle (Cy).
See reagents.

Workflow that allows you to design and run your own standard curve, melt curve, or
presence/absence experiment, including selecting experiment type, designating tasks
and targets, setting thermal cycling conditions, and performing data analysis.

Note: An experiment you create in the custom experiment workflow cannot be
accessed from the SEQ experiment workflow.
See threshold cycle (Cr).

See amplification stage.

A process during the instrument run in which an instrument component detects
fluorescence data from each well of the reaction plate. The instrument transforms the
signal to electronic data, and the data are saved in the experiment file. In the
AccuSEQ® Software, a data collection point is indicated by an icon in the thermal
profile:

¢ Data collection on:

e Data collection off:

See baseline-corrected normalized reporter (ARn).

The negative first-derivative of the normalized fluorescence generated by the reporter
during PCR amplification. In the derivative reporter (-Rn’) vs. temperature melt curve,
the derivative reporter signal is displayed in the y-axis.

See melt curve.
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electronic signature
(E-Sig)

pass result

experiment

experiment name

fail result

holding stage

inhibition control

manual baseline

manual Cy

Glossary

Administrator-configurable electronic signature function. Signatures (user name and
password) can be applied on demand. The software can also be configured to require
signatures to save, print, and/or export experiment data. Can be turned on or off.

E-Sig reports can be viewed in the SAE Manager (administrators only) and the
Experiment window.

In Mycoplasma SEQ experiments, a control result indicating:
* Positive control — Target detected
* Negative control — No target detected
¢ Inhibition control (Mycoplasma assay) — Target detected

Refers to the entire process of performing a run using the 7500 Fast instrument,
including setup, run, and analysis.

Entered during experiment setup, the name that is used to identify the experiment.
Experiment names cannot exceed 100 characters and cannot include any of the
following characters: forward slash (/), backslash (\), greater than sign (>), less than
sign (<), asterisk (*), question mark (?), quotation mark ("), vertical line (1), colon (:), or
semicolon (;).

In Mycoplasma SEQ experiments, a control result indicating:
* Positive control — No target detected (target should be detected)
* Negative control — Target detected (no target should be detected)
¢ Inhibition control (Mycoplasma assay) — No target detected (target should be
detected)

Causes of a fail result are displayed in the Results Summary and the Quality Summary.

In the thermal profile, a stage that includes one or more steps and is used to activate
enzymes, to inactivate enzymes, or to incubate a reaction.

In SEQ assay experiments, the holding stage is not editable.

A reaction solution that includes the Power SYBR® Green PCR master mix, the
unknown sample, and the positive control (Mycoplasma Real-Time PCR DNA control).
Monitors for inhibitors in the unknown sample (inhibition in the presence of a positive
target). A minimum of one inhibition control is recommended per sample.

An analysis setting in which you enter the baseline start and end values for the
amplification plot. You can apply the manual baseline setting to specific wells in the
reaction plate.

An analysis setting in which you enter the threshold value and select whether to use
automatic baseline or manual baseline values. The software uses the baseline and the
threshold values to calculate the threshold cycle (Cy).
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melt curve

melt curve stage

melting temperature
(Trr)

multicomponent plot

Mycoplasma Real-
Time PCR DNA
Control

negative control (NC)

no template control
NTC)

no target T,,

normalized reporter
(Rn)

omit well

passive reference

plate layout
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A plot of the derivative of the fluorescence versus temperature. Peaks in the melt curve
can indicate the melting temperature (T,,) of the target (Target T,,) or can identify
nonspecific PCR amplification (No Target T ,)). You can view the melt curve as
normalized reporter (Rn) vs. temperature or as derivative reporter (—Rn’) vs.
temperature. Also called dissociation curve.

In the thermal profile, a stage with a temperature increment to generate a melt curve.

In Mycoplasma SEQ and custom melt curve experiments, the temperature at which
50% of the DNA is double-stranded and 50% of the DNA is dissociated into single-
stranded DNA. The Ty, is displayed in the melt curve.

A plot of the complete spectral contribution of each dye for the selected well(s) over
the duration of the PCR run.

In Mycoplasma SEQ experiments: A specially designed plasmid DNA used as the
positive control whose amplification mimics the expected amplification of a
mycoplasma target. Target signal that is not detected in a positive-control well
indicates a pipetting error, possible inhibition, or a problem with amplification. A
minimum of one positive control is required per run.

A reaction solution that contains water or buffer instead of sample template. Monitors
for contamination (unexpected amplification in the absence of a target) and reagent
integrity. A minimum of one negative control is required per run. Also called NEG or
no template control (NTC).

See negative control (NC).

In Mycoplasma SEQ experiments: A T, in the no-target range can indicate nonspecific
PCR amplification.

Fluorescence signal from the reporter dye normalized to the fluorescence signal of the
passive reference.

An action that you perform before reanalysis to omit one or more wells from analysis.
Because no algorithms are applied to omitted wells, omitted wells contain no results.

A dye that produces fluorescence. Because the passive reference signal should be
consistent across all wells, it is used to normalize the reporter dye signal to account for
non-PCR related fluorescence fluctuations caused by minor well-to-well differences in
concentrations or volume. Normalization to the passive reference signal allows for
high data precision.

An illustration of the grid of wells and assigned content in the reaction plate. In the
7500 Fast system, the grid contains 8 rows and 12 columns.

In the AccuSEQ® Software, you can use the plate layout as a selection tool to assign
well contents, to view well assignments, and to view results. The plate layout can be
printed, included in a report, exported, and saved as a slide for a presentation.
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plot color

Polymerase Chain
Reaction (PCR])

positive control

Power SYBR® Green
PCR Master Mix

present result

premix solution

primer

primer mix

ramp

raw data plot

reaction mix

reagents

real-time PCR

region of interest
(ROI) calibration

replicates

Glossary

In Mycoplasma SEQ experiments, a color assigned to a sample in Sample Setup to
identify the sample in the plate layout and analysis plots.

Technology used to increase the amount of a DNA sequence.

See Mycoplasma Real-Time PCR DNA Control.

The master mix used to prepare the premix solution. It contains the DNA polymerase
enzyme that initiates PCR in the presence of the necessary primers and DNA sample.
It also contains SYBR® Green I dye, which binds to double-stranded (ds) DNA, thus
providing a fluorescence signal that indicates the amount of dsDNA product
generated during PCR.

In Mycoplasma SEQ experiments, a sample result indicating that target signal is present
and meets the following conditions:

¢ Within the temperature range, derivative range, and Cy range for the assay.

* Passive reference is found, noise is below threshold, positive and negative
controls have ”pass” results.

See reaction mix.

A segment of DNA that is complementary to the target DNA sequence and is needed
to start amplification.

PCR reaction component that contains the forward primer and reverse primer
designed to amplify the target.

The rate at which the temperature changes during the instrument run. Except for the
melt curve step, the ramp is defined as a percentage. For the melt curve step, the ramp
is defined as a temperature increment. In the graphical view of the thermal profile, the
ramp is indicated by a diagonal line.

A plot of raw fluorescence signal (not normalized) for each optical filter.

A solution that contains all components to run the PCR reaction, except for the
template (sample, standard, or control). Also called premix solution.

The PCR reaction components you are using to amplify the target and to detect
amplification.

Process of collecting fluorescence data during PCR.

Type of 7500 Fast system calibration in which the system maps the positions of the
wells in the sample block. ROI calibration data are used so that the software can
associate increases in fluorescence during a run with specific wells in the reaction
plate.

Total number of identical reactions containing identical samples, components, and
volumes.
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reporter

review result

Rn

ROX™ dye

run method

sample
SAE Manager

sample type

Security

SEQ experiment

workflow

SEQ template

stage

SYBR® Green
reagents
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A fluorescent dye used to detect amplification. For SYBR® Green reagents, the reporter
dye is SYBR® Green dye.

In Mycoplasma SEQ experiments, a sample result indicating that the AccuSEQ®
Software is unable to determine a result.

Causes of a review result are displayed in the Results Summary and the Quality
Summary.

See normalized reporter (Rn).

A dye supplied by Applied Biosystems and calibrated on the 7500 Fast systems. ROX
dye is used as the passive reference.

Definition of the reaction volume and the thermal profile for the 7500 Fast instrument
run.

The template that you are testing.
Controls Security, Audit, and E-Sig functions and reporting.

In SEQ experiments, the identifier you assign to a well in Sample Setup.

Sample Type options are:
. m Unknown
o Eros (positive control)
[ NEG (negative control)

* Mycoplasma SEQ experiments: If you specify inhibition controls for samples,
each sample is assigned inhibition control wells [[§.

Administrator-configurable function that controls user access to the software, manages
user accounts, and determines security policies.

Step-by-step workflow for a specific Applied Biosystems assay. The SEQ experiment
workflow calculates reagent volumes, determines optimum plate setup, guides you
through experiment set up, uses optimized thermal cycling conditions, and performs
data analysis.

Note: An experiment you create in the SEQ experiment workflow cannot be accessed

from the custom experiment workflow.

An experiment document template file (*.edt) that includes setup information
(experiment properties, sample setup, run method, and plate layout) for a specific
Applied Biosystems assay.

In the thermal profile, a group of one or more steps. There are three types of stages:
holding stage, cycling stage (also called amplification stage), and melt curve stage.

PCR reaction components designed to amplify the target and SYBR® Green dye to
detect double-stranded DNA.
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system dye

target

target T,

template

thermal profile

threshold

threshold cycle (Cy)

Tm

unknown

Glossary

Dye supplied by Applied Biosystems and calibrated on the 7500 Fast instrument.
Before you use system dyes in your experiments, make sure the system dye calibration
is current in the Instrument Maintenance Manager.
System dyes of the 7500 Fast instrument include:

e CY®3dye

e CY®5dye

* FAM" dye

e JOE™dye

e NED"dye

e ROX™dye

* SYBR® Green dye

e TAMRA"™ dye

e TEXAS RED® dye

e VIC®dye

The nucleic acid sequence that you want to amplify and detect.

In Mycoplasma SEQ experiments: The temperature at which 50% of the DNA is double-
stranded and 50% of the DNA is dissociated into single-stranded DNA. The T,
displayed in the melt curve is the T,, associated with the largest peak, which may be
the Target Ty, or the No Target T .

The type of nucleic acid to add to the PCR reaction. The recommended template varies
according to experiment type. For Mycoplasma SEQ experiments, Applied Biosystems
recommends adding DNA templates to the PCR reactions.

Part of the run method that specifies the temperature, time, ramp, and data collection
points for all steps and stages of the 7500 Fast instrument run.

1. In amplification plots, the level of fluorescence above the baseline and within the
exponential growth region The threshold can be determined automatically (see
automatic Cr) or can be set manually (see manual Cr).

2. In presence/absence experiments, the level of fluorescence above which the
software assigns a presence call.

The PCR cycle number at which the fluorescence meets the threshold in the
amplification plot.

See melting temperature (T},), no target T, target T,.

A DNA sample from media, cell culture, or other source that you are testing for the
presence of mycoplasmas.
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Documentation and Support

Related documentation

For information on new assays and updated product documentation, go to
www.lifetechnologies.com.

The following related documents are shipped with the system:

Publication

Document Description
number

Applied Biosystems 7300/7500/7500 Fast Real-Time 4347825 Provides brief, step-by-step procedures for

PCR System Absolute Quantitation Using Standard absolute quantitation using a standard curve. It is

Curve Getting Started Guide designed to help you quickly learn to use the
Applied Biosystems 7300/7500/7500 Fast Real-
Time PCR System.

Applied Biosystems 7500/7500 Fast Real-Time PCR 4387777 Explains how to maintain the 7500/7500 Fast

Systems Maintenance Guide system.
Intended for laboratory staff responsible for the
maintenance of the 7500/7500 Fast system.

MycoSEQ™ Mycoplasma Detection Kits 4393471 Provides brief, concise instructions on using the

Quick Reference MycoSEQ™ Mycoplasma Detection Kits.

AccuSEQ® Software v2.0, Custom Experiments, Quick 4425585 Provides abbreviated procedures for creating,

Reference analyzing, viewing, and interpreting custom
standard curve experiments in the AccuSEQ
software, using resDNASEQ CHO DNA kit data as
an example.

AccuSEQ® Software v2.0, Mycoplasma SEQ 4425586 Provides abbreviated procedures for creating,

Experiments, Quick Reference analyzing, viewing, and interpreting Mycoplasma
SEQ experiments using AccuSEQ® Software.

MycoSEQ® Mycoplasma Detection Kits User Guide 4465874 Describes the MycoSEQ™ Mycoplasma Detection
Kits and provides information on preparing,
running, and troubleshooting Mycoplasma
detection.

PrepSEQ® Sample Preparation Kits Quick Reference 4465875 Provides brief, concise instructions on using the
PrepSEQ® Sample Preparation Kits.

MycoSEQ™ Mycoplasma Detection Kits 4465876 Provides brief, concise instructions on using the

Quick Reference MycoSEQ™ Mycoplasma Detection Kits.

PrepSEQ® Sample Preparation Kits User Guide 4465957 Describes the PrepSEQ® Sample Preparation Kits
and provides information on preparing, running,
and troubleshooting sample preparation.

MycoSEQ™ Mycoplasma Real-Time PCR Detection Kit 4482248 Describes the MycoSEQ™ Mycoplasma Real-Time

Product Insert

PCR Detection Kit.

AccuSEQ® Software v2.0 Mycoplasma SEQ Experiments Getting Started Guide 101



Documentation and Support
Obtaining information from the Help system

Note: To open the user documentation included on the AccuSEQ®Software v2.0 CD,
use the Adobe® Reader® software available from www.adobe.com

Note: For additional documentation, see “Obtaining support” on page 102.

Obtaining information from the Help system

The AccuSEQ® Software has a Help system that describes how to use each feature of
the user interface. Access the Help system by doing one of the following:

e Click @ in the toolbar of the AccuSEQ® Software window.
e Select Help » Contents and Index.
e Press F1.

You can use the Help system to find topics of interest by:
* Reviewing the table of contents
* Searching for a specific topic

* Searching an alphabetized index

Obtaining support

For the latest services and support information for all locations, go to:
www.lifetechnologies.com/support

At the website, you can:

* Access worldwide telephone and fax numbers to contact Technical Support and
Sales facilities

® Search through frequently asked questions (FAQs)
¢ Submit a question directly to Technical Support

* Search for user documents, SDSs, vector maps and sequences, application notes,
formulations, handbooks, certificates of analysis, citations, and other product
support documents

¢ Obtain information about customer training

¢ Download software updates and patches
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review 53, 58, 61, 66, 70, 72, 74, 76, 79, 85 multiple plots, displaying 89
run notifications 45 Mycoplasma detection system, about 11
save experiment 33 Mycoplasma kit, about 13

Mycoplasma SEQ experiment
H call assessments 60

reactions 13
run method 13, 21
workflow 12

Help system, accessing 102
home screen 23

IC 28
image, save plot as 72

N

navigation tips 89
negative control 77

inhibition control select in plot 69

104 AccuSEQ® Software v2.0 Mycoplasma SEQ Experiments Getting Started Guide



Index

no target Tm 67 select in plot 68
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	High background signal
	The background fluorescence signal is higher than 1,300,000 fluorescent standard units (FSU).
	Inhibition detected
	Delta CT and Tm did not meet specified values required for “Pass.”
	NC criteria failed
	CT, DV, or Tm did not meet specified values required for negative control to“Pass.”
	No signal in well
	The well produced very low or no fluorescence.
	Not supported by IC
	CT, DV, and Tm results support absent call, but inhibition control was not run. Absent call should be supported by additional data demonstrating a lack of matrix inhibition.
	PC criteria failed
	CT, DV, or Tm did not meet specified values required for “Pass.”
	Positive control signal detected
	Peak for discriminatory positive found in sample labeled as an unknown indicating potential error in sample preparation or plate setup.
	Review CT and DV values
	Significant peak found within specified temperature range and within specified CT threshold, but DV magnitude insufficient for positive call.
	and/or
	CT and Tm results support absent call but DV magnitude too high for absent call.
	Thresholding algorithm failed
	Data did not fit thresholding model.

	About the example experiment
	View the Quality Summary
	1. Click Results in the navigation pane, then click Quality Summary.
	2. In the Quality Summary table, look in the Frequency and Wells columns to determine which call assessments appear in the experiment.
	3. Click a call assessment in the table to display more information about the assessment. The call assessment for multiple wells in the example experiment is shown below.
	4. Click a troubleshooting link below the table to view information on correcting the call assessment. An example of troubleshooting information is shown below.
	5. To investigate the data for results, review plots (see page 61).

	Guidelines for your experiment
	For more information

	Review the Amplification Plot
	About the example experiment
	View the Amplification Plots
	1. From the navigation pane, select Plot Analysis4 Amplification Plot.
	2. Display all 96 wells in the amplification plot by clicking the upper left corner of the plate layout in the Plate Layout tab.
	3. (Optional) For an expanded display of the Amplification Plot, click in the upper left corner of the plate layout in the Plate Layout tab.
	4. Select the Plot Settings tab, and adjust the plot display, as shown on page 63:
	a. From the Plot Type drop-down list, select DRn vs Cycle.
	b. From the Graph Type drop-down list, select Log.
	c. From the Plot Color drop-down list, select Well.
	d. (Optional) Deselect the Save current plot settings as the default for this experiment checkbox.

	5. Select the Options tab, then select to show the Threshold (0.2).
	6. (Optional) Select the Plot Legend tab to view the well colors assigned to each row in the plate layout.
	7. Select wells in the plate layout to view in the amplification plot (see page 89 for tips). For the example experiment, display the following replicate wells: A1, B1 (Sample 1), A6, B6 (Sample 6), H1, H2 (POS) and H11, H12 (NEG).
	While not present in this view, an inhibition control (IC) well can display a delay in amplification (CT value) as compared to the positive control (POS) well(s), indicating that inhibitors are present in the unknown sample.

	8. (Optional) To view an area of the amplification plot in detail, click:
	a. A quadrant in the plot to the left of the area you want to review.
	b. (Zoom in).

	9. (Optional) Click (Hide the plot legend).

	Guidelines for your experiment
	a. Plateau phase
	b. Linear phase
	c. Exponential (geometric phase)
	d. Baseline
	or

	For more information

	Review the Melt Curve
	About the Melt Curve
	About the example experiment
	View the Melt Curve
	1. From the navigation pane, select Plot Analysis4 Melt Curve.
	2. (Optional) For an expanded display of the 96 wells of the Melt Curve, click in the upper left corner of the plate layout in the Plate Layout tab.
	3. In the Plot Settings tab, select:
	a. Plot Type – Derivative Reporter
	b. Target – Mycoplasma Assay
	c. Color – Well

	4. (Optional) Deselect the Save current plot settings as the default for this experiment checkbox.
	5. (Optional) Select the Plot Legend tab to view the well colors assigned to each row in the plate layout.
	6. (Optional) Click (Hide the plot legend).
	7. Select wells in the plate layout to view in the melt curve plot:
	a. In the first Select Item drop-down list, select Sample Type.
	b. In the second Select Item drop-down list, select =.
	c. In the third Select Item drop-down list, select:


	Guidelines for your experiment
	For more information

	Review the table data
	About the example experiment
	View the Table View
	1. From the navigation pane, select Plot Analysis, then select the Table View tab.
	2. (Optional) For an expanded display of the Table View, click in the upper left corner of the table in the Table View tab.
	3. Use the Group By drop-down list to group wells by a specific category.
	For the example experiment:
	a. From the Group By drop-down list, select Call. Wells are listed in the order:
	b. From the Group By drop-down list, select None. In the table, click the column heading Call Assessment. Wells are sorted by the assigned call assessment. Click the column heading again to reverse the sort order and bring the wells with call assessm...

	In the example experiment:


	Guidelines for your experiment
	For more information

	Export and print the data
	For more information


	Chapter 7 (Optional) Investigate the results
	Chapter overview
	Example experiment workflow
	Start experiment
	Set up the experiment (Chapter 2)
	Prepare the reactions (Chapter 3)
	Run the experiment (Chapter 4)
	Review the Results Summary (Chapter 5)
	(Optional) Review the Results (Chapter 6)
	(Optional) Investigate the Results (Chapter 7)
	1. Review the Multicomponent Plot.
	2. Review the Raw Data Plot.
	3. Revew the Raw Data Plot.
	4. Review the analysis settings.
	5. Omit wells from the analysis.

	End experiment


	About the analysis results
	About the results
	About the example experiment
	Guidelines for your experiment

	Review the Multicomponent Plot
	About the example experiment
	View the Multicomponent Plot
	1. From the navigation pane, select Plot Analysis4 Multicomponent Plot.
	2. Select the Plot Settings tab, and adjust the plot display:
	a. From the Plot Color drop-down list, select Dye.
	b. (Optional) Deselect the Save current plot settings as the default for this experiment checkbox.

	3. (Optional) Select the Plot Legend tab to view the color assigned to each dye in the experiment.
	4. (Optional) Click (Hide the plot legend).
	5. Display the wells one at a time in the Multicomponent Plot screen:
	a. Click the Plate Layout tab.
	b. Select one well in the plate layout; the well is shown in the Multicomponent Plot screen. The plot for well A6 (= review UNKNOWN) in the example experiment is shown below.

	6. (Optional) For an expanded display of the Amplification Plot, click in the upper left corner of the plate layout in the Plate Layout tab.
	7. Check the ROX dye signal. In the example experiment, the ROX dye signal remains constant throughout the run.
	8. Check the SYBR dye signal. In the example experiment, the SYBR dye signal should not significantly increase for NEG wells, if the call for an UNKNOWN well is Absent, or if the call for a POS well is Fail. The SYBR dye signal should increase for PO...

	Guidelines for your experiment
	For more information

	Review the Raw Data Plot
	About the example experiment
	View the Raw Data Plot
	1. From the navigation pane, select Analysis4 Raw Data Plot.
	2. (Optional) Select the Plot Legend tab to view the well colors assigned to each row in the plate layout.
	3. Display all 96 wells in the Raw Data Plot screen by clicking the upper left corner of the plate layout in the Plate Layout tab.
	4. In the Plate Layout tab, select wells corresponding to sample replicates. For the example experiment:
	5. Click and drag the Show Cycle pointer from cycle 1 to cycle 138, and review the data from each filter:
	The filters are:
	Dye(s)
	FAM™ dye
	SYBR® Green dye
	JOE™ dye
	VIC® dye
	TAMRA™ dye
	NED™ dye
	Cy®3 dye
	ROX™ dye
	Texas Red® dye
	Cy®5 dye

	The filter data from cycle 37 for Sample 6 in the example experiment is shown below.

	6. Repeat step 4 and step 5 for each sample replicate.
	7. (Optional) Click (Hide the plot legend).

	Guidelines for your experiment
	For more information

	Review the analysis settings
	About the example experiment
	View the analysis settings
	CT Settings
	Call Settings
	Set CT limits for calls
	Range settings

	QC and Noise Settings
	1. Click Analysis in the top menu, then Analysis Settings.
	2. Click the QC and Noise Settings tab.
	3. To change the default Enable setting for quality check flags, click Disable.
	4. To edit the high background threshold, enter a value in the data entry field.
	5. To edit the peak noise threshold, enter a value in the data entry field.

	Restore default analysis settings
	Save edited analysis settings
	Guidelines for your experiment
	Threshold
	Enter a value for the threshold so that the threshold is:
	Baseline
	Select Start Cycle and End Cycle values so that the baseline ends before significant fluorescence is detected.

	For more information

	Omit wells from the analysis
	About the example experiment
	Omit wells
	1. Click Plot Analysis in the navigation pane. The software displays the Amplification Plot screen by default.
	2. In the Plate Layout tab, select one or more wells to omit from analysis (see page 89 for tips).
	3. Right-click the well(s), then select Omit. For example:
	Results for the well are removed (indicated by ).

	4. Click Analyze to re-analyze the data without the omitted wells.
	5. Specify a reason for change, if prompted. For more information, see “Security, Audit and E-Signature (SAE) for users” on page 87.

	Guidelines for your experiment
	1. From the navigation pane, select Plot Analysis4 Amplification Plot.
	2. In the Amplification Plot screen, select CT vs Well from the Plot Type drop-down list.
	3. Select the Table View tab, then review the table data:
	a. Look for any outliers.
	b. Select the Omit check box next to the outlying well(s).

	4. Click Analyze to re-analyze the experiment data with the outlying well(s) removed from the analysis.
	5. Specify a reason for change, if prompted. For more information, see “Security, Audit and E-Signature (SAE) for users” on page 87.

	For more information


	Appendix A Reference Information
	Security, Audit and E-Signature (SAE) for users
	Security
	To access the software, you provide a user name and password. If your system is configured for periodic password expiration, you will periodically be prompted to change your password. If your system is configured to monitor consecutive failed log in ...
	Audit
	If your system is configured for auditing, you may be prompted to specify a reason when you make certain changes in the software.
	Additionally, you can generate and print an experiment audit report that includes all audit records for an experiment.
	Electronic Signature
	If your system is configured for electronic signature, you may be prompted to provide your user name and password when you perform certain actions in the software.
	You can also sign an item on-demand (for example, you can sign results after viewing them).
	If an item is set to require two signatures, the signers are not required to sign at the same time. When the first signer signs, the E-Sig status is set to Partially Signed. When the second signer signs, the E-Sig status is set to Signed.
	Additionally, you can generate and print an electronic signature report that all electronic signature records for an experiment.

	Navigation tips
	How to select wells in the plate layout
	1. To change the data displayed in the Plate Layout, click Show in Wells, then select (or deselect) the data to display in the plate layout.
	2. To select wells of a specific type, use the Select drop-down lists. Select a well position; omit a well; or select a sample name, sample type, assay, CT, call, call assessment, target Tm, or DV. Use filters to specify your selection, for example, ...
	3. To select one well, click the well in the plate layout.
	4. To select multiple wells, click and drag over the desired wells, or press Ctrl-click or Shift-click in the plate layout.
	5. To select all 96 wells, click the top-left corner of the plate layout.

	How to display multiple plots
	1. From the navigation pane, select Plot Analysis4 Multiple Plots View.
	2. To display four plots, click Show plots in a 2 X 2 matrix.
	3. To display two plots in rows (default view), click Show plots in two rows.
	4. To display two plots in columns, click Show plots in two columns.
	5. To display a specific plot, select the plot from the drop-down list above each plot display.


	SEQ template workflow
	Create a template
	1. Double-click (AccuSEQ Software).
	2. Enter your user name and password, then click OK.
	3. Open an existing SEQ experiment (see page 42), or create a new SEQ experiment (see page 23).
	4. Select File4Save As Template.
	5. Enter a file name, select a location for the template, then click Save.
	Click Close.


	Save a template as an experiment
	1. In the Home screen, click Open Experiment.
	2. From the Files of Type list, select Experiment Document Template files (*.edt).
	3. Locate and select the template to use, then click Open.
	4. (Optional) Modify the setup information from the template, as needed:
	5. Select File4Save As to save the template as an experiment (*.eds file type).
	6. Enter a file name, select a location to save the experiment. then click Save.
	7. Specify a reason for change, if prompted. For more information, see “Security, Audit and E-Signature (SAE) for users” on page 87.
	8. Run the experiment, as needed.

	Create an experiment with a template
	1. Select File4New Experiment4From Template.
	2. Locate and select the template to use (*.edt file type), then click Open. A new experiment (*.eds file type) is created using the setup information from the template:
	3. (Optional) Modify the setup information from the template, as needed.
	4. Click Save to save the experiment.
	5. Enter a file name and select a location for the experiement, then click Save.
	6. Specify a reason for change, if prompted. For more information, see “Security, Audit and E-Signature (SAE) for users” on page 87.
	7. Run the experiment, as needed.
	Glossary
	absent result
	amplification
	amplification plot
	amplification stage
	assay
	Audit
	AutoDelta
	automatic baseline
	automatic CT
	baseline
	baseline-corrected normalized reporter (DRn)
	CT
	chemistry
	custom experiment workflow
	cycle threshold
	cycling stage
	data collection
	delta Rn (DRn)
	derivative reporter (- Rn¢)
	dissociation curve
	electronic signature (E-Sig)
	pass result
	experiment
	experiment name
	fail result
	holding stage
	inhibition control
	manual baseline
	manual CT
	melt curve
	melt curve stage
	melting temperature (Tm)
	multicomponent plot
	Mycoplasma Real- Time PCR DNA Control
	negative control (NC)
	no template control (NTC)
	no target Tm
	normalized reporter (Rn)
	omit well
	passive reference
	plate layout
	plot color
	Polymerase Chain Reaction (PCR)
	positive control
	Power SYBR® Green PCR Master Mix
	present result
	premix solution
	primer
	primer mix
	ramp
	raw data plot
	reaction mix
	reagents
	real-time PCR
	region of interest (ROI) calibration
	replicates
	reporter
	review result
	Rn
	ROX™ dye
	run method
	sample
	SAE Manager
	sample type
	Security
	SEQ experiment workflow
	SEQ template
	stage
	SYBR® Green reagents
	system dye
	target
	target Tm
	template
	thermal profile
	threshold
	1. In amplification plots, the level of fluorescence above the baseline and within the exponential growth region The threshold can be determined automatically (see automatic CT) or can be set manually (see manual CT).
	2. In presence/absence experiments, the level of fluorescence above which the software assigns a presence call.

	threshold cycle (CT)
	Tm
	unknown

	Documentation and Support


	Related documentation
	Applied Biosystems 7300/7500/7500 Fast Real-Time PCR System Absolute Quantitation Using Standard Curve Getting Started Guide
	4347825
	Provides brief, step-by-step procedures for absolute quantitation using a standard curve. It is designed to help you quickly learn to use the Applied Biosystems 7300/7500/7500 Fast Real- Time PCR System.
	Applied Biosystems 7500/7500 Fast Real-Time PCR Systems Maintenance Guide
	4387777
	Explains how to maintain the 7500/7500 Fast system.
	Intended for laboratory staff responsible for the maintenance of the 7500/7500 Fast system.
	MycoSEQ™ Mycoplasma Detection Kits Quick Reference
	4393471
	Provides brief, concise instructions on using the MycoSEQ™ Mycoplasma Detection Kits.
	AccuSEQ® Software v2.0, Custom Experiments, Quick Reference
	4425585
	Provides abbreviated procedures for creating, analyzing, viewing, and interpreting custom standard curve experiments in the AccuSEQ software, using resDNASEQ CHO DNA kit data as an example.
	AccuSEQ® Software v2.0, Mycoplasma SEQ Experiments, Quick Reference
	4425586
	Provides abbreviated procedures for creating, analyzing, viewing, and interpreting Mycoplasma SEQ experiments using AccuSEQ® Software.
	MycoSEQ® Mycoplasma Detection Kits User Guide
	4465874
	Describes the MycoSEQ™ Mycoplasma Detection Kits and provides information on preparing, running, and troubleshooting Mycoplasma detection.
	PrepSEQ® Sample Preparation Kits Quick Reference
	4465875
	Provides brief, concise instructions on using the PrepSEQ® Sample Preparation Kits.
	MycoSEQ™ Mycoplasma Detection Kits Quick Reference
	4465876
	Provides brief, concise instructions on using the MycoSEQ™ Mycoplasma Detection Kits.
	PrepSEQ® Sample Preparation Kits User Guide
	4465957
	Describes the PrepSEQ® Sample Preparation Kits and provides information on preparing, running, and troubleshooting sample preparation.
	MycoSEQ™ Mycoplasma Real-Time PCR Detection Kit Product Insert
	4482248
	Describes the MycoSEQ™ Mycoplasma Real-Time PCR Detection Kit.

	Obtaining information from the Help system
	Obtaining support
	Index
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